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Overview

/)
INTRODUCTION

Welcome to RealServer™, the most powerful server for streaming
media files across an intranet or the Internet. This manual will help
you use and optimize RealServer for real-time delivery of

multimedia files.

This guide is intended for the technical system administrator who will manage
RealServer and its activities, but not necessarily create the material to be
streamed. Information on creating content is available in a companion book,
RealSystem G2 Production Guide.

IS professionals, server administrators, Web masters and others providing Web
pages for the Internet and intranet may also find this document useful.

RealServer Administration Guide is also available online at

http://service.real.com/help/library/index.html.

How This Manual Is Organized

This manual contains the following chapters:

Chapter 1, “Quick Start”
This chapter gives step-by-step instructions on getting RealServer started and
running quickly.

Chapter 2, “What’s New in RealServer G2?”
If you're familiar with previous versions of RealSystemTM, this chapter will give
you a quick update on the new features in RealServer version 7.0.

Chapter 3, “Overview”
This chapter gives the “big picture” of how RealServer works with a Web server
to stream media to client software such as RealPlayer®.
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Chapter 4, “Sources of Content”

In order to serve clips to users, you first need to get the content. This chapter
describes two methods (RealProducer Plus and G2SLTA) for creating
content.

Chapter 5, “Understanding Link Formats”
This chapter describes how to construct the links to your content.

Chapter 6, “Starting and Stopping RealServer”

This is a guide to starting and stopping RealServer. Depending on which
platform your RealServer runs on, different automatic options are available.
The license structure is discussed.

Chapter 7, “Customizing RealServer Features”

Modifying RealServer by changing settings in the configuration file is the key
to fine tuning RealServer features. Whether you use the RealSystem
Administrator or edit the configuration file directly, this chapter describes
how to make changes to RealServer.

Chapter 8, “Advanced Features”

This chapter discusses differences between RealServer on the different
platforms, media caches, firewalls, and the assignment of IP addresses for
RealServer’s use.

Chapter 9, “Firewalls and RealServer”
If you are delivering content to users on the Internet, you’ll want to know how
RealServer and other RealSystem products interact with firewalls.

Chapter 10, “Streaming On-Demand Presentations”
In this chapter, instructions are given for delivering pre-recorded or prepared

clips.

Chapter 11, “Unicasting Live Presentations”
Live clips are streamed much like static clips, with a few differences. Learn how
to make broadcasting work well.

Chapter 12, “Splitting Live Presentations”
Splitting can help you make the best use of bandwidth and can provide
highest-quality reception.
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Chapter 13, “Multicasting Live Presentations”

Multicasting is a way of sending a single live stream to multiple clients, rather
than sending a stream to every single client. Clients connect to the stream,
rather than to the RealServer.

Chapter 14, “Limiting Access to RealServer”
You can limit access to RealServer by specifying restrictions such as maximum
bandwidth and IP addresses.

Chapter 15, “Authenticating RealServer Users”
Control and limit who can view your content; this chapter describes the
different RealServer authentication methods and the advantages of each.

Chapter 16, “Storing Authentication Data”
RealServer comes with some different methods for tracking authentication
information. Use such data for billing or to track who’s watching what.

Chapter 17, “ISP Hosting”
If you are an Internet Service Provider (ISP), you can host streaming media on
behalf of your customers.

Chapter 18, “Monitoring RealServer Activity”

To provide highest-quality service, you’ll want to keep track of how many
people are accessing your RealServer. This chapter describes the different
methods of watching Server activity.

Chapter 19, “Reporting”

You’ll want to look at trends and see what content is most popular. RealServer
can report player behavior with a customizable degree of detail. Errors are
reported in their own log, which can help you troubleshoot any problems that
arise.

Chapter 20, “Streaming Targeted Ads”
RealServer can automatically insert advertisements into presentations. This
chapter describes the many options available within this feature.

Chapter 21, “Troubleshooting”
Any problems? This chapter lists good steps to take when you’re not sure
what’s wrong. It also lists error messages and tells what to do about them.
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Appendixes

Appendix A, “Summary of Link Formats”
A quick reminder of the structure of URLs for all the different types of content
and delivery formats for streamed media.

Appendix B, “Configuration File Syntax”
This appendix consists of a discussion of the XML syntax used by the
configuration file.

Appendix C, “Configuration File Contents”
This is a guide to the configuration file contents, for those who prefer to edit
it directly rather than using RealSystem Administrator.

Appendix D, “Configuration File Equivalents”

For those RealServer administrators who’ve worked with a previous version of
RealServer, this chapter lists settings in the old configuration file along with
their new XML-based equivalents.

Conventions in This Manual

This section explains some conventional terms and formats used throughout
the manual

Terminology

Because this manual is aimed at the RealServer administrator, the term “you”
refers to the administrator. People or customers who play clips served by

» o«

RealServer are referred to as “visitors,” “viewers,” or “users.”

RealSystem clients, such as RealPlayer, are referred to generically as “clients”.
Where information applies specifically to the RealNetworks RealPlayer or
RealPlayer Plus™, this is spelled out. Although most clients in use are
RealNetworks’ own RealPlayer, RealNetworks also makes a software
development kit that enables other companies to develop their own players
which can also receive streamed data types.

RealSystem production tools, which create the files and data that RealServer
streams, are referred to simply as “encoders.”

» «

“Clips,” “content,” “media files,” and “files” are used interchangeably to

indicate the material that RealServer streams.
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The following table explains the typographic conventions used in this manual:

Notational Conventions

Convention Meaning

syntax Syntax of configuration files, URLs, or command-line instructions
are given in this typeface.

variables Italicized text represents variables. Substitute values appropriate for
your system.

emphasis Bolded text is used for emphasis.
Ellipses indicate nonessential information omitted from the
example.

[] Square brackets indicate optional material. If you choose to use the

material within the brackets, do not type the brackets themselves. An
exception to this is in the access log, where statistics generated by the
StatsMask variable are enclosed within actual brackets.

Sample Links
Examples of links that point to the RealServer are given like this:

RealServer.company.com
where:

RealServer is meant to be the machine name of the computer that is running
your RealServer. Substitute the name of your organization’s computer where
you see this text.

company.com is meant to be an example of a domain name. Substitute the
domain name of your organization’s machines where you see this text.

Default Locations and Values

In all the examples shown in this book, it is assumed that you installed
RealServer in the default location for your operating system, and that you are
using default values for all settings. You can certainly customize RealServer to
meet your needs; default values are shown in this manual for clarity.

On Windows-based platforms, the default installation directory is C:\Program
Files\Real\RealServer. For UNIX-based platforms, the default installation
directory is /usr/local/RealServer.
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Available Features

Depending on which RealServer product you purchased, some of the features
described in this manual may not be available to you or may be limited in
some way (such as the number of streams you can transmit simultaneously).
Consult your license file for a list of which features are enabled on your
RealServer. If you would like to add to your RealServer’s capabilities, contact
RealNetworks or your reseller.

Additional Information
Instructions on reading license files with RealSystem
Administrator are given in “License Information” on
page 88.

Additional RealSystem Resources

In addition to this manual, you may need the following RealNetworks
resources, available at http://service.real.com/help/library/index.html.

* RealSystem G2 Production Guide

This manual explains the basics of creating streaming files with the
RealSystem tools. It tells how to calculate bandwidth needs and shows
how to put a multimedia presentation together. To view this manual, click
Resources under Help in RealSystem Administrator.

« Embedded RealPlayer Extended Functionality Guide

This guide supplements RealSystem G2 Production Guide. It explains how to
use JavaScript or VBScript to control RealPlayer functions for a
presentation embedded in a Web page.

* RealText™ Authoring Guide

This manual explains how to create streaming text. You can use RealText,
for example, to create a live stock ticker feed or provide video subtitles.

* RealPix™ Authoring Guide

With RealPix you can create streaming slide shows of still images. RealPix
Authoring Guide tells you how to put a slide show together and use special
effects such as fades and zooms.
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* RealProxy™ Administration Guide

If you are using RealProxy software, or are working with someone who is,
this manual describes the use of RealProxy and configuration
information.

» RealSystem G2 Software Development Kit (SDK)

RealNetworks has developed a Software Development Kit (SDK) that lets
you integrate applications with RealSystem or create new plug-ins for
RealServer or RealPlayer. Knowledge of programming is required to use
the SDK. Register for and download the SDK from
http://www.realnetworks.com/devzone/.

Technical Support

General troubleshooting steps and information about contacting
RealNetworks technical support are given in Chapter 21, “Troubleshooting”.
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QUICK START a

This chapter gives step-by-step instructions on getting RealServer

started and running quickly.

Overview

In this chapter, you’ll walk through simple steps for:
- Starting RealServer
» Using RealSystem Administrator to test your RealServer
- Playing sample files
« Creating and streaming your own on-demand clips
» Creating and broadcasting live events

Prerequisites

Instructions in this chapter assume that you have already installed RealServer.

You’ll also need the items below, though they can be located on a different
computer than RealServer:

» RealPlayer version 6.0 or later

+ Multimedia equipment: CD player, sound card, speakers, and software
that allows you to play and hear music CDs.

« RealProducer Plus
« Text editor for creating an HTML page (optional)
« Web browser (optional)

For playing sample clips, you’ll need a second computer with RealPlayer
installed, and multimedia equipment.

RealProducer Plus and RealPlayer are included with some RealServer
packages, and are available in free download versions from the RealNetworks
Web site at http://www.realnetworks.com.




CHAPTER 1: Quick Start RealServer Administration Guide

Starting RealServer

Common methods for starting RealServer are listed below. There are also
other options for startup, and more details, described in Chapter 6, “Starting
and Stopping RealServer”. If your RealServer does not start, consult Chapter
21, “Troubleshooting”.

Windows 95 and Windows 98

On the Start menu, click Programs>Real>RealServer. This starts the
rmserver.exe program.

A command window appears, and shows the files loaded. It then displays
process ID (PID) numbers. You can leave this window on-screen, or minimize
it.

Windows NT

When you install RealServer on Windows NT, by default it installs itself as a
service, and runs automatically. If it isn’t running, start it with the Windows
95/98 instructions above.

UNIX
Move to the main RealServer directory and type the following:

Bin/rmserver rmserver.cfg

Using RealSystem Administrator to Test Your RealServer

RealSystem Administrator is the Web-based system you’ll use to manage your
RealServer. From RealSystem Administrator, you can customize your
RealServer, play sample clips, and monitor activity.

Note
After you install RealServer, RealSystem Administrator
automatically appears. If RealSystem Administrator is
currently running, you can skip this section.

If RealSystem Administrator does not start, consult Chapter 21,
“Troubleshooting”.

0 To use RealSystem Administrator:

1. Start a Web browser from anywhere on your network.

10
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2. In the browser’s address or location box, type the following URL,
substituting your values for address and AdminPort:

http://address:AdminPort/admin/index.html

The setup program generates a random value for AdminPort if you did not
supply one. If you’re not sure what number to use, refer to “How do I
figure out which port number to use for RealSystem Administrator?” on
page 340.

3. You are prompted for your user name and password. Use the same user
name and password you created during setup.

If you don’t remember your user name or password, consult “How do I
look up my user name and password?” on page 340.

4. Click OK.

RealSystem Administrator starts.

Playing Sample Files

In the left-hand frame of RealSystem Administrator, click Samples. A new
frame appears on the right, with links to sample clips. Click any one of these
to test your RealServer. (The computer you'’re using needs a sound card and
speakers so that you can hear the audio portion of the clips.)

« To hear RealAudio®, click Play in the RealAudio G2 Music Codec area.
+ To see RealVideo®, click Play in the RealSystem G2 SureStream area.

» To see a SMIL presentation that uses RealPix  and RealText®, click the
first Play button in the RealPix, RealText, SMIL area.

- To see a Real G2 with Flash™ presentation, click Play in the Real G2 with
Flash area.

If the clip plays correctly, you’re ready to begin streaming! If you encounter
any difficulties, consult Chapter 21, “Troubleshooting”.

You can also play any sample clip by typing its address in RealPlayer. Start
RealPlayer and choose File>Open Location.

« To play the RealAudio clip, type rtsp://address:554/g2audio.rm
« To play the RealVideo clip, type rtsp://address:554/g2video.rm

« To play the first SMIL presentation, type
rtsp://address:554/houseg2/house.smi

11
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« To play the RealFlash presentation, type
rtsp://address:554/debreuilg2/debreuil.smi

where address is your computer’s IP address or DNS name. Click OK, and the
presentation plays.

As you will see later in this chapter, the format for URLs you type in RealPlayer
is slightly different than the format used in the HTML code of Web pages.
Examples of both formats are given in each chapter.

Creating and Streaming Your Own On-Demand Clips

This section describes how to create a very simple music file and then stream it
from your RealServer. You’ll need a music CD, and RealProducer Plus G2
version 6.1. Other versions of RealProducer Plus may have slightly different
steps than the ones shown below; if you have a different software version, use
these steps as a guide.

Part 1: Create the Music Clip

In this example, you’ll encode your music CD directly to a file, and then move
it to a location from which RealServer can stream it. There are many ways you
can optimize the encoding to make the best possible listening experience, but
these instructions are brief so that you can hear results quickly.

Additional Information
To learn more about options for encoding, refer to
RealProducer Plus User’s Guide, available at
http://service.real.com/help/library/index.html

O To create the music clip:

1. Put a music CD in the computer’s CD player and start playing it, using
your system CD player. (Do not use RealJukebox, as it will not initialize
the audio device needed for encoding.)

2. Start RealProducer Plus.

« In RealProducer Plus for Windows or Macintosh, the New Session-
Choose Recording Wizard dialog box appears. Place a check mark in
the Don’t Use Recording Wizards box. Click OK, then click Cancel.

« In RealProducer Plus for UNIX, the main RealProducer Plus program
is visible.

12
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3
4
S.
6
7.

10.

11.
12.

13.

14.

15.
16.
17.

. Choose File>New Session. A dialog box appears.

. In the Input Source section, select Media Device.

Place a check mark in Capture Audio and uncheck Capture Video.

. In the Output area, select RealMedia File.

In the box below it, type the file name ondemand.rm. (Always use the .rm
extension.)

Mew Session

. Click OK.

The New Session dialog box closes, returning to the RealProducer Plus
main window.

. Verify that Multi-rate SureStream for RealServer G2 is selected.

In the Target Audience area, make sure the boxes 28K Modem and 56K
Modem are selected.

Leave all other fields blank.

Choose Controls>Start.

A message appears, asking if you want to add clip information.

Click No.

RealProducer Plus begins recording your music CD. The word “Encoding”
appears in the lower left corner.

Wait one minute, then click Stop.

A message appears, asking if you want to stop encoding.
Click Yes.

Click Close.

Click Yes.

13
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RealProducer Plus halts the recording and creates a file named
ondemand.rm in the RealProducer Plus directory, or in the directory
location you specified in Step 7.

Part 2: Put the Music Clip in the Content Directory

Copy the file ondemand.rm clip you created in the previous section, which is
currently located in the main RealProducer directory, to the RealServer
Content directory.

In Windows 95, Windows 98, and Windows NT, the path is C:\Program
Files\Real\RealServer\Content.

In UNIX, the path is /usr/local/RealServer/Content.

Part 3: Create a Link (Optional)

Create a link for the clip in a Web page. (The Web page can be local; it does not
have to be on a remote Web server.)

In a Web page, type the following link and save the page (substitute your
RealServer’s machine name or IP address for address):

<a href="http://address:8080/ramgen/ondemand.rm">Click here to listen to my
(D</a>

The word “ramgen” tells RealServer to instruct the Web browser to start
RealPlayer. The Ramgen feature is described in “Ram Files and Ramgen” on
page 69.

Part 4: Play the Sample Clip

If you added the link to the Web page in Step 3, use a Web browser to view the
page. Click the link that says “Click here to listen to my CD”. RealPlayer starts,
and you hear the one-minute clip you created.

To play this in RealPlayer without using a Web page, start RealPlayer and
choose File > Open Location. Type this URL and then click OK:

rtsp://address:554/ondemand.rm

14
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Creating and Broadcasting Live Events

In this section, you’ll encode your music CD directly to your RealServer and
broadcast it while it encodes. You’ll listen to it from a second computer.

Instructions in this section create a demonstration audio clip, using a music
CD, and RealProducer Plus G2 version 6.1. Other versions of RealProducer
Plus may have slightly different steps than the ones shown below; if you have
a different software version, use these steps as a guide.

Part 1: Encode the Event

There are many ways you can optimize the encoding to make the best possible
listening experience, but these instructions are brief so that you can hear
results quickly.

Additional Information
To learn more about options for encoding, refer to
RealProducer Plus User’s Guide, available at
http://service.real.com/help/library/index.html

O To create a live clip:

1. Put a music CD in the computer’s CD player and start playing it, using
your system CD player. (Do not use RealJukebox, as it will not initialize
the audio device needed for encoding.)

2. Start RealProducer Plus.

« In RealProducer Plus for Windows or Macintosh, the New Session-
Choose Recording Wizard dialog box appears. Place a check mark in
the Don’t Use Recording Wizards box. Click OK, then click Cancel.

« In RealProducer Plus for UNIX, the main RealProducer Plus program
is visible.
3. Click File>New Session. A new dialog box appears.
4. In the Input Source section, select Media Device.
5. Place a check mark in Capture Audio and uncheck Capture Video.
6. In the Output area, select Live Broadcast.

a. In the RealServer box, type the IP address of the machine on which
your RealServer is installed.
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. In the Server Port box, leave the default setting of 4040.

In the Filename box, type live.rm. (Always use the .rm extension.)

. In the Username box, type the same user name you use for logging in

to RealSystem Administrator.

In the Password box, type the password you use for RealSystem
Administrator.

Uncheck the box labelled Display this broadcast in Project Janus.

Mew Seszsion

17223100210
4040

live.mm

7. Click OK.

The New Session dialog box closes, returning to the RealProducer Plus

main window.

8. Verify that Multi-rate SureStream for RealServer G2 is selected.

9. In the Target Audience area, make sure the boxes 28K Modem and 56K
Modem are selected.

10. Leave all other fields blank.

16
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11. Click Start.
A message appears, asking if you want to add clip information.

12. Click No.

RealProducer Plus begins encoding your music CD.

Part 2: Create a Link (Optional)
Create a link for the live broadcast in a Web page. (The Web page can be local;
it does not have to be on a remote Web server.)

In an existing Web page, type the following link and save the page (substitute
your RealServer name or IP address for address):

<a href="http://address:8080/ramgen/encoder/live.rm">Click here to listen to my
CD</a>

Part 3: Play the Clip

Go to a second machine that has a sound card, speakers, and RealPlayer
installed.

1. Using a Web browser, view the page that you just edited.
2. Click the link that says “Click here to listen to my CD”.
RealPlayer starts, and you join the music broadcast in progress.

To play this in RealPlayer without using a Web page, start RealPlayer and
choose File > Open Location. Type this URL and then click OK:

rtsp://address:554/encoder/live.rm
The word “encoder” tells RealServer to look for live input from RealProducer

Plus or other encoding software.

Notice that there are a few seconds of delay on your system. Encoding is not
instantaneous, plus the music must travel over the network to the second
machine. This delay ensures reliability and cannot be eliminated.

When you have finished with this demonstration, click Stop in RealProducer
Plus to halt the live encoding.

17
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RealServer G2 is designed on a new architecture that allows greater

WHAT’S NEW IN REALSERVER G2?

extensibility and interoperability with third-party solutions.

New Features in RealServer Version 7.0

This version of RealServer includes the features described below.

View Source Code of SMIL Files

The view source feature allows users of RealPlayer version 7.0 to view the
source code for SMIL presentations or media clips.You can also browse the
on-demand content available to your RealServer.

Additional Information
Refer to “Displaying Source Code for SMIL Files and
Media Clips” on page 99.

Pending Changes Page in RealSystem Administrator

As you make changes to RealServer using RealSystem Administrator, those
modifications that require you to restart RealServer are listed on a Pending
Changes page. The Restart Server button at the top of the RealSystem
Administrator window changes color to indicate that new changes are ready to
be implemented, and a Pending Changes button appears as well.

Additional Information
See “Using RealSystem Administrator” on page 93.

SureStream Support for G2SLTA and Live File Archiving
Previous versions of RealServer did not archive SureStream files, nor could

SureStream files be included in a simulated live event.

Additional Information

See “Creating a Live Source with G2SLTA” on page 46.
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Multicast Shift to Unicast Feature
Scalable multicast now includes a feature that allows clients to receive unicast

transmissions if their multicast connections fail.

Additional Information

See “Using Unicast as a Backup Method” on page 204.

Ad Server Integration with RealServer
Dynamically add a streaming advertisement to a requested media clip.

Integrate with ad servers and services seamlessly.

Additional Information

See Chapter 20, “Streaming Targeted Ads”.

ISP Hosting Support
As in versions 3.0, 4.0, and 5.0, RealServer G2 7.0 can segment its streams and

host content on behalf of other users.

Additional Information

See Chapter 17, “ISP Hosting”.

Log Rolling for Both Access Log and Error Log Files
Version 6.0 introduced the ability to automatically limit the size of access logs.

In RealServer version 7.0, error logs can also be limited.

Additional Information

See Chapter 19, “Reporting”.

RealServer G2 Version 6.0 Features

This section lists the features which were new to RealServer G2 version 6.0.

License Files

Previous versions of RealServer used an encrypted license key string, which
was used during installation and placed in the configuration file, to indicate
which features were available.

RealServer G2 introduces new license files that allow for greater flexibility in
upgrading available features.

20
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Additional Information
See “License Information” on page 88.

RealSystem Administrator

RealServer G2 includes RealSystem Administrator, a new HTML interface for
working with nearly every aspect of Server operations. Use this tool to fine-
tune RealServer features, monitor Server activity, and play sample
presentations.

RealSystem Administrator can be accessed from any Web browser on the
network. Security features for RealSystem Administrator are also included.

Additional Information
See Chapter7, “Customizing RealServer Features”.

New Protocols

RealServer G2 now uses RealTime Streaming Protocol (RTSP) as its control
protocol and RealNetworks’ proprietary RDT as its packet protocol.

New URL Format

A visible change in this version of RealServer is the change in URLs that point
to RealServer presentations.

« URLs that point to G2 presentations begin with rtsp://.

» Included in the URLs are mount points and virtual directories. These tell
RealServer which file system to use in processing the presentation request.

Additional Information
See Chapter 5, “Understanding Link Formats”.

New Configuration File Format

The configuration file, which stores all the settings used by the RealServer, is
now in Extensible Markup Language (XML) format. This new format allows

greater flexibility and extensibility by third parties. The file is easy to modify
with the new RealSystem Administrator, or you can still use a text editor to

make changes.

Additional Information
See Chapter B, “Configuration File Syntax”.
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Open Architecture

Most features are handled by separate files, called plug-ins. Located in the
plug-ins directory, these plug-ins are read by RealServer when it starts and
they control what happens to client requests. The RealServer open
architecture allows third-party companies to develop plug-ins that can be
added easily to RealServer for future functionality. This open architecture
lends itself to modularity and customization.

Additional Information

See Chapter C, “Configuration File Contents”.

New Splitting Method
In addition to the splitting method of previous versions, splitters can now

rebroadcast material upon request.

Additional Information

See “Pull Splitting” on page 157.

Control Access to Ports Based on IP Address

RealServer G2 allows you to limit access to RealServer based on the IP address
of the requesting client just as earlier versions did, but RealServer G2 adds the
ability to restrict access to certain ports. In this way, you can better control
traffic flow on your RealServer computer.

Additional Information

See “Limiting Access Via IP Address” on page 212.

Authentication
New options for verifying the identity of visitors to your RealServer

presentations include Windows NT authentication.

Additional Information
See Chapter 15,“Authenticating RealServer Users”.

New Monitoring Methods
Use the constantly updating Java Monitor in RealSystem Administrator.

Zoom in for a closer look. Change the colors of the display.

Additional Information

See “Java Monitor” on page 273.
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If you have Windows NT, use the NT Performance Monitor with the
RealServer rmserver.pmc file.

Additional Information

See “Optional Java Monitor Features” on page 276.

Integration with Windows NT User Groups

RealServer works with Windows NT User Authentication to give access to
users who are already in the NT user group lists.

Additional Information

See “Windows NTLM Challenge/Response”.

Compatibility With Previous Releases

RealServer version 7.0 is fully compatible with RealServer 3.0 and later.
Presentations created with earlier versions of RealSystem tools still work
seamlessly with RealServer G2; place them in the Content directory. To use
encoding software that was developed before RealSystem G2 version 6.0 (such
as RealVideo Encoder 4.0), use the information in “Pre-G2 Encoders” on page
143.

To use new features, such as RealText, in an existing presentation, you must
update the presentation by creating a SMIL file and modifying the URL that
refers to the presentation.

23






ter

3

Welcome to RealServer, the streaming media solution! RealServer

OVERVIEW

streams audio, video, image, animation, text, and other data types.
RealServer also allows you to grow with your changing needs. This
chapter introduces RealServer concepts and features.

To begin serving right away, consult Chapter 1, “Quick Start”.

What Is RealServer?

RealServer is software that streams media—both pre-recorded and live events—
over a network. The client receives the media in real time, and does not have to
wait for the clip to download.

Components of RealServer
RealServer software consists of the following components:

« Executable—RealServer’s main software, called rmserver.exe for Windows
platforms, and rmserver for UNIX platforms.

« Plug-ins—these files provide the functionality of RealServer’s individual
features. Because of this open architecture, third parties can create custom
features, allowing you to extend the abilities of your RealServer.

« Configuration file—a text file, based on XML format, that stores all of
your RealServer’s customized information. The configuration file name is
rmserver.cfg.

+ License file—one or more files which control the features enabled in your
RealServer.

+ RealSystem Administrator—a Web-based console for customizing and
monitoring your RealServer.
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« Tools—additional software tools such as the Java Monitor, which allows
you to view how many clips are being served at a given time, and G2SLTA,
which broadcasts pre-recorded clips as if they were live events.

» Other files—depending on the particular RealServer package you
purchased, your installation may have other files that perform additional
functions, such as commerce or ISP hosting.

What is RealSystem?

RealServer is a member of the RealSystem G2 family of software tools. Three
components make up RealSystem G2:

« Production tools—such as RealProducer Pro or RealProducer Plus that
create media (such as audio, video, or animation)

« RealServer—which streams media
+ Client software—such as RealPlayer, which plays the streamed media
The following diagram provides an overview of how RealSystem components

work together.

RealSystem Components

Encoder RealServer RealPlayer

&6

Production Tools
The person who designs the content that you serve from your RealServer uses
production tools to create the content. These tools convert audio, video, or

" e

animation to a data type format that RealServer can stream.

The content creator may additionally create a SMIL file to synchronize several
clips in a single presentation. A SMIL file coordinates the playing and layout
of media clips in parallel or sequence.

Since RealServer is able to deliver many formats, there are many tools that can
be used in creating content. Production tools can optimize the material for
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delivery over the Internet, based on the content of the material and the
expected capabilities of the users’ equipment.

The content creator can prepare media clips in advance, or can encode a live
event as it happens. In this manual, we use the generic term “encoder” to
describe the software (such as RealProducer) that converts media or events
into a format that RealServer can deliver.

RealServer

Just as a Web server delivers pages to Web browsers over the Internet,
RealServer serves media clips, created with the production tools described
earlier, to clients. It allows users to stream, rather than download, the media
clips. By streaming the content, the user can begin to watch the clip almost
immediately and does not have to wait for the entire file to download.

Client Software

A client such as RealPlayer plays the streamed media.

Other Software
In addition to the RealSystem G2 software, you may work with additional
optional software, such as:

« Web server

« Web browser

« Firewalls

« Networking software

« Database software, if commerce authentication features are in use

« Ad server or services, if advertising features are in use

How RealServer Works

RealServer streams media to clients over networks and the Internet. It is
usually employed in conjunction with a Web server. Some RealServer features
can interact with third-party products to create specialized functions, such as
report analysis.

Channels and Protocols

RealServer uses two connections, known as “channels,” to communicate with
clients: one for communication with the client, and one for actual data. The
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communication channel is known as the “control channel,” since it is over this
line that RealServer requests and receives passwords, and the client sends
instructions such as fast-forward, pause, and stop. Media is actually streamed
over a separate “data channel”.

Every link to content begins with a protocol identifier, such as rtsp, pnm, or
http.
RealServer uses two main protocols to communicate with clients: RTSP (Real

Time Streaming Protocol) and PNA (Progressive Networks Audio).

Occasionally, RealServer will use HTTP for metafiles that point to RealServer
content, and for the HTML pages served by RealServer (such as the Web-based
RealSystem Administrator). It may also be used in delivering clips to clients
that are located behind firewalls.

Within these channels, RealServer uses two other protocols for sending
instructions and data:

+ TCP—sends commands from the client such as “start” and “pause,” and
from RealServer to clients for information such as the clips’ titles

« UDP—sends the actual data

See Chapter 9, “Firewalls and RealServer” for more detailed information on
RealServer’s use of ports.

Occasional Exceptions

Because many firewalls are configured to allow only TCP connections or
HTTP traffic, you may need to make some adjustments to receive data from
an encoder or to work with clients if there is a firewall between it and your
RealServer. See Chapter 9, “Firewalls and RealServer”.

Communication Between Encoder and RealServer

When the encoder connects to RealServer and sends encoded media data, it
uses a one-way (UDP) connection to communicate with RealServer.
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UDP Connection Between Encoder and RealServer

One-way UDP o) ‘.

Encoder RealServer

Some firewalls do not permit UDP packets, so RealNetworks encoding
software such as RealProducer has a setting that uses TCP connections to send
the same encoded media, since many firewalls allow TCP traffic.

TCP Connection Between Encoder and RealServer

Encoder RealServer

m.‘.

Communication Between RealServer and RealPlayer

When the user clicks a link that points to a media presentation, RealPlayer
opens a two-way connection with RealServer. This connection uses TCP to
send information back and forth between RealPlayer and RealServer.

Initial TCP Control Connection

RealServer RealPlayer

° ‘°(. ®
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Once RealServer approves the request, it sends the requested clip along a one-
way UDP channel.

UDP Data Connection

RealServer RealPlayer

0 G -2y TCP control connection
Ona-way UDP stream (. .

As it receives the streamed clip, RealPlayer plays it at high fidelity.

Streaming Delivery Methods

There are two main ways for controlling how a user experiences a clip:

+ On-demand—like renting a video at a 24-hour video store, the clip is
available to the user whenever she wants. The user can fast-forward,
rewind, pause, and RealServer sends the right part of the clip. This type of
clip is pre-recorded or pre-assembled.

« Live—like a live telecast of the Olympic Games, users tune in to the action
that is happening now. A user can’t fast-forward or rewind through the
clip, because the event is happening in real time. To deliver content as a
live event requires that there actually is a live event, and that you or the
content creator have the software and hardware to capture it and convert
it to a media format that RealServer can broadcast.

A third method, which uses on-demand clips but delivers them as if they were
live, is available. It is not used as commonly.

» Simulated live—Just as a television broadcaster might record a live event
and broadcast it later, such as Olympic sports that wouldn’t be seen
because of time zone differences, simulated live broadcasts take a pre-
recorded event and broadcast it as a live event. Thus, although it is pre-
recorded, users view the event as if it were live.
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The table below summarizes the three participation types.

User Participation Comparisons
On-Demand (through Streaming) Live Delivery (through Unicasting, Simulated Live Delivery (through
Splitting, or Multicasting) Unicasting, Splitting, or
Multicasting)

Can access presentations any Can only access presentations Same as live delivery.

time. while they’re in-progress.

Files are stored on disk. Presentations don’t exist as files. | Same as on-demand delivery.

Presentations always begin Everyone sees the same part of the | Same as live delivery.

streaming at the beginning of | presentation at the same time—

the file. late-comers join in the middle.

User can fast-forward through | User plays the clip all the way Same as live delivery.

the clip or pause it at any point. | through.

Similar to a videotape of past Similar to live television coverage |Similar to a previously recorded

Olympic event highlights. of an Olympic event. Olympic event, delayed on
television because of time zone
differences.

Which Delivery Method Is Right for Me?

Once you have determined how you want the user to experience the clip (as
on-demand or live), you choose which delivery method you will configure
RealServer to use.

+ On-demand—the choice is simple: streaming is the only delivery method.

+ Live and simulated live—there are three ways to deliver the clip:
unicasting, splitting, and multicasting.

On-Demand Streaming

Pre-recorded clips are delivered through a method called streaming. A user
who clicks a link to an on-demand clip watches it from the beginning. The
user can fast-forward, rewind, or pause the clip. See Chapter 10, “Streaming
On-Demand Presentations”.

Live Event Broadcasting

Live clips can be delivered in several different ways. As the administrator, you
will decide which method to use based on your network needs. A user who
clicks a link to a live clip joins the live event in progress; fast-forward, rewind,
and pause are not available because the event is happening in real time.
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Live clips are broadcast as they are created. These clips don’t exist as files, since
they are created as the live event happens. Live content can be saved into files
through the live archiving feature; the archived files become on-demand
content and are handled as such.

Unicasting

This is the simplest and most popular method for live broadcasting. It
requires little or no configuration. Refer to Chapter 11, “Unicasting Live
Presentations”.

Splitting

Splitting is a term to describe how one RealServer can share its streams with
other RealServers. Clients connect to these other RealServers, called splitters,
rather than to the main RealServer where the streams originate. Splitting
reduces the load on the source RealServer, leaving it free to distribute other
broadcasts. This method moves the broadcasts closer to clients, improving the
quality of service for them. See Chapter 12, “Splitting Live Presentations”.

Multicasting

Multicasting is a standardized method for connecting large numbers of users
with presentations delivered over a network or the Internet. Consult Chapter
13, “Multicasting Live Presentations”.

Simulated Live Event Broadcasting

The same delivery options are available as for live broadcasting: unicasting,
splitting, and multicasting. The only difference is that the event has already
been recorded, and no connection to a production tool or encoder is needed.
The G2SLTA program, included with RealServer, sends the on-demand file to
RealServer as if it were a live event. See “Creating a Live Source with G2SLTA”
on page 46.
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Summary

The following table shows the user participation styles and the accompanying

delivery methods.

Comparison of Delivery Methods

User Delivery
Participation Method Appropriate Use Requirements
On-demand | Streaming Presentations that are limited to | Requires sufficient bandwidth to
the number of licensed handle the number of clients
connections, CPU speed, amount | connecting.
of RAM, and available bandwidth
of a single machine.
Live and Unicasting | Broadcasts that are limited to the | Requires sufficient bandwidth to
simulated live number of licensed connections, | handle the number of clients
CPU speed, amount of RAM, and | connecting.
available bandwidth of a single
RealServer machine.
Splitting Broadcasts that are limited to the |Requires at least two RealServers.
number of licensed connections, | Must configure source RealServer
CPU speed, amount of RAM, and | and splitter RealServers.
available bandwidth of all
RealServer machines.
Multicasting | Broadcasts that will be viewed by | Requires a multicast-enabled

unlimited users around the globe
on a multicast-enabled network.

network. Can be combined with
splitting to cover a greater
geographical region where
networks are not multicast-

enabled.

In some cases, you can use more than one live delivery method at once, to

reach the maximum number of users while minimizing network bandwidth.

» The combination of splitting and multicasting is described in “Splitting

and Multicasting” on page 185.

+ The combination of unicasting and multicasting is described in
“Requiring Multicast Access Rather than Unicast” on page 198 (for back-
channel multicast) and “Using Unicast as a Backup Method” on page 204

(for scalable multicast).
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Linking to RealSystem Content

Links to media clips served by RealServer have several components that tell
RealServer how to serve the clip and where to look for the clip.

Content creators will put most links into Web pages. A user looking at a
content creator’s site will click the link, and through the process described in
“How RealServer Works”, will receive the media.

For example, the following link for a RealVideo file would appear in a Web
page (the URL for the media clip is shown in bold):

<a href="http://RealServer.company.com:8080/ramgen/Concerts/French/

debussy.rm”>Click here to watch today’s concert!</a>

The clip may be pre-recorded, live, or pre-recorded but delivered as live.

Additional Information
Instructions on creating links to RealSystem clips are
described in depth in Chapter 5, “Understanding Link
Formats”.

Working with Other Webcasting Professionals

This manual assumes that you (the RealServer administrator) are managing
your RealServer, and that a second person (the content creator) is making
media clips and SMIL presentations and putting links in Web pages. In reality,
you may be filling both roles, especially when you are setting up a feature and
want to do some quick tests. But it makes it easier to discuss the roles when
they are described as separate people.

The RealServer administrator needs to provide the content creator with
certain information, so that she can create the correct links in her SMIL files
and Web pages. If the content providers are encoding live material, they will
need to know where to direct their live data.

Responsibilities of RealServer Administrator and Content Creator

RealServer Administrator Content Creator

Configures and maintains RealServer Performs encoding or assembles
presentations

Supplies information needed to create Creates links

links
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Content Creators of On-Demand Content

Content creators will need the following information:
« Location where they should place their files
» Address or name of RealServer

» Port numbers for each protocol (but only if you have changed them from
the recommended default settings)

« Information about whether Ramgen is in use (Ramgen is defined in “Ram
Files and Ramgen” in Chapter 5, “Understanding Link Formats”.

Content Creators of Live Content
In order to encode a live stream to RealServer, content creators need to know
this information:

« Address or name of RealServer

« Port number to connect to

« Authentication information such as passwords (if any)

« URL to use in Web pages that point to a live broadcast or multicast

« URL to use in a SMIL file

Other RealServer Administrators

RealServer can broadcast to other RealServers, which can redistribute the
presentations to clients, thus reducing the load on the original RealServer.
This feature is called splitting. If you are working with the administrator of
the other RealServer (the splitter), you will need to give that person certain
information about your RealServer settings. That information is outlined in
Chapter 12, “Splitting Live Presentations”.

Firewall Administrators

If there are users within your network that either cannot receive presentations
from RealServers on the Internet or who receive poor quality streams,
information in Chapter 9, “Firewalls and RealServer” will help the firewall
administrator understand what changes can be made that will enhance the
users’ experience.

Network Administrators

In determining both how much bandwidth is available on your network, and
how much is appropriate for RealServer to use, network administrators can
help you arrive at suitable numbers.
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RealServer Features

In addition to the delivery methods described earlier in this chapter,
RealServer has other features that help you administer your RealServer.

RealSystem Administrator

RealSystem Administrator is the Web-based console for customizing
RealServer features. It can be run from any browser on your network. It is
password-protected when first installed, and you can create additional user
names and passwords for any other people who will be helping you administer
your RealServer.

Access Control

The access control feature lets you associate certain client addresses with the
ability or permissions to connect to certain ports.

Authentication

Authentication verifies the identity of a user or RealPlayer that is making a
request for streamed media. The verification can come in the form of asking
for a name and password, or it can be hidden from the user.

ISP Hosting

RealServer works with your existing user accounts and directory structure to
make users’ media files available for streaming. You allocate a minimum and
maximum number of connections for each account, based on the number of
streams permitted by your license. Allocating on a per-connection basis, rather
than by stream, ensures that all files, including SMIL files which reference
multiple streams, will always be served.

Monitoring

RealSystem Administrator includes a real-time Java Monitor to show activity
on your RealServer, making Server management easy. It shows who is using
the Server, when it is most used, and which files are the most requested, as well
as other information.

Reporting (Log Files)
RealServer can create reports of historical data that let you see trends and
gather information. Track who visited your site and for how long; what clips
they watched and whether they watched them all the way through to
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completion. This information is stored in the access log. Any error messages
are recorded in the error log. Requests for streams which will be cached are
stored in the cached requests log.

Ad Streaming

RealServer can dynamically insert ads into streaming presentations. Offering
integration with any HTML-based ad serving system, RealServer uses SMIL
(Synchronized Multimedia Integration Language) to lay out ads and
requested content in RealPlayer. This chapter explains how to set up
RealServer’s ad streaming features.

RealProxy

RealProxy is software that stores streamed media. While it is not part of
RealServer G2, it can work with RealServer to share the distribution load,
thereby conserving bandwidth over an intranet and allowing RealServers to
send streams to a wider audience. It is generally installed on an intranet or on
a large Internet Service Provider (ISP). When a client on the intranet or hosted
by the ISP requests a streamed media file, RealProxy intercepts the request and
sends it on behalf of the client. RealProxy then stores the requested media and
streams it to any other clients who subsequently request the same material.

Firewalls

Firewalls are not specifically a RealServer feature, but they are important in
networked environments. A firewall is a software program that monitors, and
sometimes controls, all transmissions between an organization’s internal
network and the Internet. A network can consist of a company’s local area
networks, wide area networks, and the Internet, or it can be just an Internet
Service Provider preventing inappropriate access to the files of its customers.
The firewall's role is to ensure that all communication, in both directions,
conforms to the organization’s security policies.

Using RealServer Features Together

RealServer components can be combined to conserve bandwidth and deliver
high-quality presentations. The table below summarizes RealServer features
and how they work together.

For additional information on exactly how any of these features work
together, refer to the chapter that describes the feature.
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Interoperability of RealServer Features
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* Features work together automatically; no additional configuration required beyond normal
setup

§ Requires some special considerations for these features to work together

— Not applicable; features are unrelated
! Firewall information assumes that firewall allows streaming media traffic and multicast traffic
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This chapter gives quick instructions on how to create an on-
demand or a live file with RealProducer Plus. It also describes
G2SLTA, the tool for broadcasting an on-demand file as if it were

live.

RealServer can stream many other file types, which are not described in this
chapter. Consult the RealNetworks Web site for information about additional
file types.

Once you have created or started encoding your source, you’ll create a link for
it, so that users can receive your content. The link will go in a Web page or a
Ram file.

Sources of Content

A content creator can make a file and then place it in a location available to
your RealServer, or she can encode it (using encoding software such as
RealProducer Plus) and send it to your RealServer as it happens.

RealServer can serve the following file formats (check your license to see which
of these your RealServer can serve):

Audio File Types | RealAudio, WAV, AU, MPEG-1", MPEG-2", MP3"

Video File Types RealVideo, AVI, QuickTime

Other File Types RealPix, RealText, GIF, JPEG, SMIL, Real G2 with Flash

“MPEG-1, MPEG-2, and MP3 are supported by optional plug-ins from
Digital Bitcasting. See http://www.bitcasting.com for more information.
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In addition to serving your own on-demand and live files, you can also serve
content distributed by another RealServer. This is called splitting. It is
described in Chapter 12, “Splitting Live Presentations”.

SMIL Files

Synchronized Multimedia Integration Language files, or SMIL files, are files
that coordinate the delivery of several clips. A SMIL file (pronounced “smile”)
tells the client what clips to play, in what order, and where to show them on
the screen. SMIL files can perform basic or sophisticated timing and layout. A
SMIL file can refer to both on-demand and live clips.

Additional Information
For detailed information on creating SMIL files, see
RealSystem G2 Production Guide. To view this manual,
click Resources under Help in RealSystem
Administrator.

Delivery Methods

For most file types, you can determine which of two ways the user will
experience the clip:

+ On-demand—whenever a user wants to play content, he can click a link
and play the clip from the beginning. He can pause it, fast forward
through it, or rewind it.

« Live—like tuning into a network television broadcast, each user who clicks
a link to live content plays the clip at the same time. Users who click the
link after the broadcast has started miss the beginning of the show. Time-
based options available to on-demand streams—pause, fast forward,
rewind—are not available.

A third method, simulated live, is experienced by the user as a live clip.

Additional Information

See “Streaming Delivery Methods” on page 30.

For every presentation, you will need a source clip, whether it is on-demand or
live.
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Creating an On-Demand Source with RealProducer Plus

Instructions in this section create a brief, one-minute demonstration audio

clip, using a music CD, and RealProducer Plus G2 version 6.1. Other versions

of RealProducer Plus may have slightly different steps than the ones shown

below; if you have a different software version, use these steps as a guide.

Additional Information
To learn more about options for encoding, refer to
RealProducer Plus User’s Guide, available at
http://service.real.com/help/library/index.html.

Part 1: Creating the Clip

1.

g O v AW

Put a music CD in the computer’s CD player and start playing it, using
your system CD player. (Do not use RealJukebox, as it will not initialize
the audio device needed for encoding.)

. Start RealProducer Plus.

« In RealProducer Plus for Windows or Macintosh, the New Session-
Choose Recording Wizard dialog box appears. Place a check mark in
the Don’t Use Recording Wizards box. Click OK, then click Cancel.

+ In RealProducer Plus for UNIX, the main RealProducer Plus program
is visible.

. Choose File>New Session. A dialog box appears.

. In the Input Source section, select Media Device.

. Place a check mark in Capture Audio and uncheck Capture Video.
. In the Output area, select RealMedia File.

. In the box below it, type the file name ondemand.rm. (Always use the .rm

extension.)

If you are encoding on the same machine as RealServer, you can type the
complete path in RealProducer Plus.

Note
File names must consist of one word, with no spaces.

. Click OK.
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10.

11.
12.

13.

14.

15.
16.

The New Session dialog box closes, returning to the RealProducer Plus
main window.

. Verify that Multi-rate SureStream for RealServer G2 is selected.

In the Target Audience area, make sure the boxes 28K Modem and 56K
Modem are selected.

Leave all other fields blank.

Choose Controls>Start.
A message appears, asking if you want to add clip information.
Click No.

RealProducer Plus begins recording your music CD. The word “Encoding”
appears in the lower left corner.

Wait one minute, then click Stop.

A message appears, asking if you want to stop encoding.
Click Yes.

Click Close.

RealProducer Plus halts the recording and creates a file named
ondemand.rm in the RealProducer Plus directory, or in the directory
location you specified in Step 7.

Part 2: Copying the Clip to RealServer

Copy the file ondemand.rm clip you created in the previous section, which is

currently located in the main RealProducer directory, to the RealServer
Content directory.

In Windows 95, Windows 98, and Windows NT, the path is C:\Program
Files\Real\RealServer\Content.

In UNIX, the path is /usr/local/RealServer/Content.

Part 3: Linking to the On-Demand Clip

Create a link for the clip in a Web page. (The Web page can be local; it does not

have to be on a remote Web server.)

In a Web page, type the following link and save the page (substitute your

RealServer’s machine name or IP address for address):

42



RealServer Administration Guide CHAPTER 4: Sources of Content

<a href="http://address:8080/ramgen/ondemand.rm">Click here to listen to my
CD</a>

You can now view this Web page in a browser. When you click the link,
RealPlayer will start and will play your ondemand.rm file.

You can also play the clip by starting RealPlayer, clicking File>Open Location,
and typing the following in the dialog box that appears:

rtsp:address:554/ondemand.rm

Information on how to create links to your content is described in Chapter 5,
“Understanding Link Formats”.

Note
Notice that you must use the same capitalization in the
link as you did when you created the file name, as they
are case-sensitive.

Creating a Live Source with RealProducer Plus

Instructions in this section create a demonstration audio clip, using a music
CD, and RealProducer Plus G2 version 6.1. Other versions of RealProducer
Plus may have slightly different steps than the ones shown below; if you have
a different software version, use these steps as a guide.

Additional Information
To learn more about options for encoding, refer to refer
to RealProducer Plus User’s Guide, available at

http://service.real.com/help/library/index.html.

Other sources of live content are described elsewhere in this chapter; see
“Creating a Live Source with G2SLTA”.

There are two steps to setting up and running RealProducer Plus:
1. Starting the live encode.

2. Creating a link to the live event.

Part 1: Starting the Live Encode with RealProducer Plus

1. Put a music CD in the computer’s CD player and start playing it, using
your system CD player. (Do not use RealJukebox, as it will not initialize
the audio device needed for encoding.)
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2. Start RealProducer Plus.

« In RealProducer Plus for Windows or Macintosh, the New Session-
Choose Recording Wizard dialog box appears. Place a check mark in
the Don’t Use Recording Wizards box. Click OK, then click Cancel.

« In RealProducer Plus for UNIX, the main RealProducer Plus program
is visible.

3. Click File>New Session. A new dialog box appears.
4. In the Input Source section, select Media Device.
5. Place a check mark in Capture Audio and uncheck Capture Video.

6. In the Output area, select Live Broadcast.

a. In the RealServer box, type the IP address of the machine on which
your RealServer is installed.

You can type the name (such as RealServer.company.com) of your
RealServer instead.

b. In the Server Port box, leave the default setting of 4040.

c. In the Filename box, type live.rm. (Always use the .rm extension.)

If this broadcast is to be authenticated, use the path /secure/live.rm.
See “Setting Up Authentication for Live Content” in Chapter 15,
“Authenticating RealServer Users” for more information.

Note
File names must consist of one word, with no spaces.

d. In the Username box, type the same user name you use for logging in
to RealSystem Administrator.

(To create an additional user name and password for each person who
will be encoding to your RealServer, see “Encoder User
Authentication” on page 235.)

e. In the Password box, type the password you use for RealSystem
Administrator.

f. Uncheck the box labelled Display this broadcast in Project Janus.
7. Click OK.

The New Session dialog box closes, returning to the RealProducer Plus
main window.
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8. Verify that Multi-rate SureStream for RealServer G2 is selected.

9. In the Target Audience area, make sure the boxes 28K Modem and 56K
Modem are selected.

10. Leave all other fields blank.
11. Click Start.

A message appears, asking if you want to add clip information.

12. Click No.

RealProducer Plus begins encoding your music CD.

Part 2: Linking to the Live Event

These instructions describe a unicasting link in a Web page. For more
sophisticated delivery methods, consult Chapter 12, “Splitting Live
Presentations” and Chapter 13, “Multicasting Live Presentations”.

Create a link for the live broadcast in a Web page. (The Web page can be local;
it does not have to be on a remote Web server.)

In an existing Web page, type the following link and save the page (substitute
your RealServer name or IP address for address):

<a href="http://address:8080/ramgen/encoder/live.rm">Click here to listen to my
(D</a>

Tip
Be sure to use the same file name extension in the link
as you typed in the encoder. RealServer will not supply a
missing or incorrect extension.

The word /encoder/ alerts RealServer that this is a live broadcast. Everything
after /encoder/ is a file name or a path and file name. The path can be an
actual path that matches directories in RealServer, or it can be a virtual path
that you use to distinguish this broadcast from others. Virtual paths are
described in greater detail later in this chapter.

You can also play the clip by starting RealPlayer, clicking File>Open Location,
and typing the following in the dialog box that appears:

rtsp:address:554/encoder/live.rm

Information on how to create links to your content is described in Chapter S,
“Understanding Link Formats”.
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Note
Be sure to use the same capitalization in the link as in
the file name, as file names are case-sensitive.

Virtual Paths

In some cases, in the encoding software, you may want to supply a virtual path
that doesn’t actually exist. The notion of a virtual path is only applied to live
content. In RealProducer Plus, the path name is typed in the Filename box.

Virtual paths can be useful in segmenting your streams. For example, if the
accounting department and the marketing department regularly encode
announcements made by their department heads, you can tell each
department to use its department name so that you don’t have to worry about
each department using the same name for its broadcast. The accounting
department can encode to /accounting/update.rm, and the marketing
department can encode a clip named /marketing/update.rm. Both streams will
be named update.rm, but because of the virtual path name, each department’s
stream remains distinct, and viewers in the different departments will see the

right clip as they click the appropriate link.

The Connection Between Encoder Paths and Links

The filename and path you type in the encoding software will always be
reflected in the link to the resulting content. For example, if you type
videos/familyreunion/1999/reunion.rm in the encoder, the link in the Web page
to the clip will look like:

http://RealServer.company.com:8080/ramgen/encoder/videos/familyreunion/1999/
reunion.rm

If you are using the directory structure created by RealServer at installation,
you don’t have any directories named encoder or videos or familyreunion or
1999. But because /encoder/ is the mount point, and because you typed the rest
of the path in the encoding software and matched them in the link,
RealServer is able to find the clip.

Creating a Live Source with G2SLTA

The G2SLTA (Simulated Live Transfer Agent) software tool converts an on-
demand stream to a live event. It simulates the encoder’s connection to
RealServer. Just as in an actual live broadcast, viewers who watch a
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presentation join the event in progress; no matter when visitors connect, they
all see the same thing at the same time.

This feature also allows you to create a playlist that cycles through a set of pre-
recorded clips in a certain order.

You can stream RealAudio, RealVideo, AU, and WAV clips using 62SLTA. Only
audio and video files can be delivered as live content with G2SLTA. Data types

such as RealText and RealPix cannot be used; they have their own live delivery
utilities. For more information, see RealPix Authoring Guide and RealText

Authoring Guide at http://service/help/library/index.html.

You start 62SLTA from a command line. Just as if you were creating a live
encoding session, you assign a name to the “live” broadcast, and supply a user
name and password.

G2SLTA Command Line

C:\Real\RealServer>Bin\g2slta.bat realserver.company.com 4040 pbrown
swordfish annual.rm Content\Annual_Report.txt

As G2SLTA runs, it displays the name of the file it is broadcasting. A line of
asterisks indicates how much of the file has been broadcast, in percent. (A row
of asterisks that lines up below the number five indicates that the file is
approximately 50 percent complete.)

G2SLTA Showing Progress Through Playlist

b files.

Encoding CompanylLogo.rm...
0----1-=-=2===-3=-=cbimz-=5oncfzm-T-c-=8-===0=-=-10
B R R S T
Encoding Welcome.rm...
0----1-=-=2--=-3=-=-bimz-=5oefzm=-T-===8-===0=-=-10
EEE R R R R R R R R R R R R R R R
Encoding President.rm...
0----1----2----3----4----5----f----7----8----9----10
EEE R R R R R R R R R R R R R R R R R
Encoding Treasurer.rm...
0----1----2----3----4----5----f----7----8----9----10
EEE R R R R R R EEEEEEEEREEEEEEREEEEREEEEEEEES
Encoding Conclusions.rm...
0----1----2----3----4----5----f----7----8----9----10

EEEEEEEEEEEEEEEEEEEREREEEEEEEEEEEEEEEESESES

Done.
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After playing the files according to the -r and -n switches in the command line
(if any), G2SLTA displays the word Done. If you use the -n switch without a
number (to create an infinite loop), 62SLTA will not ever show Done because it
will always be playing a file.

When to Use G2SLTA

The following are examples of when to use G2SLTA instead of live broadcasting:
+ Rebroadcasting a live event for a later time zone
- Creating a looped presentation of one or more files
- Simulating a radio station by creating a playlist with a long list of files
« Testing your system in anticipation of an actual live broadcast

» Periodically re-broadcasting popular content, such as a concert during a
telethon, or news headlines throughout the day

G2SLTA and Other RealServer Features

G2SLTA works with all other RealServer live broadcasting features.

On-Demand Streaming and G2SLTA

On-demand clips are “converted” to live clips as 62SLTA sends them to
RealServer.

Live Unicasting and G2SLTA

Use G2SLTA to test your equipment for doing live broadcasting before the
event starts, and work out any bugs. Make sure you have the correct links.

Archiving G2SLTA Broadcasts

The live archiving feature can create static files of all live files that arrive from
an encoder. RealServer will use the same archive settings as for other
broadcasts, whether it is configured to create one large file from each
broadcast or several smaller files. If the live archiving feature is configured to
save one large file, it will use the name you specified in livefile in the command
line (see “G2SLTA Syntax” on page 53). For small files, it will use the name
specified by livefile, and appending numbers at the end (see “Small Files” on
page 147).
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Note
If you start 62SLTA with the infinite loop instruction
(omit the -n switch from the command line), and the
live archive feature is set up to create a single large file
from the broadcast, RealServer will not create an archive
file until you end the broadcast. Then it will create one
large file.

If the live archiving feature is turned on for all arriving streams (the * in the
Virtual Directories list), all broadcasts from 62SLTA will automatically be
archived.

Splitting and G2SLTA

You can use simulated broadcasts as a live source for splitting. See “Creating a
Source for Splitting” on page 58.

Multicasting and G2SLTA

You can use simulated broadcasts as a live source for multicasting. See
“Creating a Source for Multicasting” on page 59.

Access Control, Authentication, and G2SLTA

In order for a broadcast to be authenticated, it must use the /secure/ mount
point. The value you use for livefile must include the /secure/ mount point.

A client that connects to any live broadcast that uses G2SLTA as its live source
will be authenticated in the usual manner.

Java Monitor and G2SLTA

As with all live events, you can monitor the number of clients connected to a
live broadcast by using the Java Monitor.

The broadcast created by G2SLTA appears in the Java Monitor as a typical
encoder connection.

Reporting and G2SLTA

Just as in any other live broadcast, a record is created in the access log for any
client that connects to a live broadcast simulated by 62SLTA.
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Setting Up and Running G2SLTA
There are four steps to setting up and running G2SLTA:
1. Configuring RealServer.
2. Creating a playlist.
3. Running G2SLTA.

4. Creating the link to the simulated live broadcast.

Use the following instructions to set up and run G2SLTA.

Step 1: Configuring RealServer
In these steps you will:
« set up RealServer as for encoding
- confirm the encoder password information

- get other broadcasting information.

Configuring RealServer to Work with G2SLTA:
G2SLTA uses the same configuration settings as live unicasting. See “G2
Encoders” on page 142.

Looking Up Password Information

You will need to supply a user name and password in the 62SLTA command
line. By supplying a user name, you allow RealServer to authenticate you and
verify that the simulated stream is authorized.

Generally, you use the user name and password that you supplied during
RealServer setup. This information was automatically added to the list of
authorized encoder users.

O To look up password information:

1. In RealSystem Administrator, click Security. Click Authentication.
2. In the Realms list, select SecureEncoder.

3. Click Browse Users in Realm. A new browser window appears.

a. Examine the names in the list. There may be only one (the user name
you use for connecting to RealSystem Administrator, which you
created during Setup).

b. Click Close. You are returned to RealSystem Administrator.
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4. If you did not see a user name that you want to use when running G2SLTA,
click Add a User to Realm. Refer to instructions in Chapter 15,
“Authenticating RealServer Users” for information on how to customize
the new user name and password.

5. Make a note of the user name and password you want to use. This
information will go on the command line, as described in “G2SLTA
Syntax” on page 53.

Looking Up Broadcasting Information
To run 62SLTA, you need to know the correct port number to use.
O To look up encoding information:

1. In RealSystem Administrator, click Broadcasting. Click G2 Encoder.

2. Make a note of the values for Port and for Mount Point.

Step 2: Creating a Playlist
The playlist is a text file that contains a list of the files that 62SLTA will stream.

« If you want to simulate a live broadcast of only one file, either create a
playlist that refers to just that file, or substitute the file’s name for the
playlist parameter in the command line.

« If you have a series of files you want to play during your simulated live
broadcast, list them in sequence in the playlist. An optional command
plays files in a playlist in random order.

You can include as many files as you like in the playlist.

All files in the playlist must have been encoded at the same bit rates. Any
SureStream files in the playlist must contain the same quantity of bit rates,
and the bit rates must be the same among all files.

Warning
Do not combine both SureStream files and non-
SureStream files in the playlist.

When you start 62SLTA, you give a name to the stream which will be used as
the file name that will be included in the URL. The playlist name is not
included in the URL.
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O To create a playlist:

In a text file, list each file that you want RealServer to play, one per line. Files
are played in the order shown in the file.

Format of Playlist
first_file
second_file

If the files are not in the same directory as the playlist, be sure to include their
full paths, whether absolute or relative to the location of the playlist.

Example Playlist
For example, a file named Annual_Report.txt might contain the following
items:

CompanyLogo.rm
Welcome.rm
President.rm
Treasurer.rm
Conclusions.rm

For more playlist features, see “Optional G2SLTA Features” later in this
chapter.

Step 3: Running G2SLTA

Note
Running g2slta.exe, rather than the batch file or shell
script, will result in error messages. The batch file and
the shell script set two environment variables:
G2SLTA_PLUGIN_PATH and G2SLTA_SUPPORT_PATH, are set
with the values of variables PluginDirectory and
SupportPluginDirectory. The file G2SLTA.BAT or g2slta.sh
is customized with your values for these variables when
you install RealServer. (To view the values of
PluginDirectory and SupportPluginDirectory, search for
them in the configuration file; they are not shown in
RealSystem Administrator.)

O Torun G2SLTA:

1. At a command line in the Bin directory, run 62SLTA.BAT (Windows) or
g2slta.sh (UNIX), using the syntax shown below.
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G2SLTA Syntax

The 62SLTA program uses the following format:

Windows

g2slta.bat host port username password livefile playlist [-r] [-nN] [-bN]

UNIX

g2slta.sh host port username password livefile playlist [-r] [-nN] [-bN]

where:

host

port

username

password

livefile

playlist

-nN

-bN

Name of the RealServer system and domain name, or IP address.

Port number specified in the G2 Encoder list, usually 4040. See
“Looking Up Broadcasting Information” on page 51.

Name of the encoder user as defined in the encoder realm. Often the
same as the username for RealSystem Administrator. See “Looking
Up Password Information” on page 50. If no username has been
defined, type two quotation marks: "".

The corresponding user’s password. Often the same as the password
for RealSystem Administrator. See “Looking Up Password
Information” on page 50. If no password has been defined, type two
quotation marks: ""

Name of the broadcast that you want to include in the URL that links
to this event.

Name of your playlist. If it is in a different directory than the
RealServer directory, include its path.

If you are broadcasting a single file, you can give its full path and
name here, instead of referencing a playlist.

Optional. Indicates that RealServer should randomly play the files in
the playlist. See “Playing Files in Random Order” on page 54 for
further discussion.

Optional. Gives the number of files in the playlist for RealServer to
play. When this switch is omitted, the list of files plays indefinitely.
See “Specifying Number of Times to Play Files” on page 54 for more
information.

Optional. Gives the target bandwidth to stream from a SureStream

file; RealServer will stream the bandwidth of N. Give the number in

bits per second. For example, -b20000 will stream the 20 kilobit bit-
rate stream. See “Controlling Bandwidth” on page 55 for additional
information.
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G2SLTA Example

The following example command starts a simulated live broadcast. The user
name is pbrown and the password is swordfish. The filename that users will
connect to is annual.rm. Files are specified by the playlist named
Annual_Report.txt. Switches for random play and bandwidth are omitted,;
therefore the files will play in the order listed in the playlist, and all the
bandwidths are available to clients. Since there are five files in the playlist, -n5
is used to indicate that each file should be played once. In this example, the
command is typed from the main directory, thus the commands are preceded
with the path to the Bin directory.

Windows

Bin\g2slta.bat RealServer.company.com 4040 pbrown swordfish annual.rm
Content\Annual_Report.txt -n5

UNIX

Bin/g2slta.sh RealServer.company.com 4040 pbrown swordfish annual.rm
Content/Annual_Report.txt -n5

Optional G2SLTA Syntax
This section discusses the three optional command line options, which are
also shown in “G2SLTA Syntax” on page 53:

» Playing files in random order
« Specifying number of times to play files

« Controlling bandwidth from all SureStream files

Playing Files in Random Order
The -r switch instructs G2SLTA to stream the files in the playlist in random
order.

Tip
Use both the -r and -nN switches, where N is a multiple of
the number of files in the playlist, to cycle randomly
through the playlist N times.

Specifying Number of Times to Play Files
The -nN switch gives the total number of files to play from the playlist. Notice
that it does not indicate the number of times each file should be played.

To play each file in the playlist once, count the number of files in the playlist,
and use that value for N.
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To indicate that RealServer should play seven files, include -n7 in the
command line. If a playlist contains three files, RealServer will play the file
sequence twice, and will play the first item a third time, for a total of seven

files played.

Using the example playlist which contains five files (shown in “Example
Playlist” on page 52), the switch -n7 would play the following files:

CompanylLogo.rm (first time)
Welcome.rm (first time)
President.rm (first time)
Treasurer.rm (first time)
Conclusions.rm (first time)
CompanylLogo.rm (second time)
Welcome.rm (second time)

To play through each file in the playlist x times, multiply x by the number of
files in your playlist and use it for N.

Another way to think of this switch:

« If the value for N is the same as the number of the files in the playlist, each
file in the playlist will be played once.

« If the value for N is less than the number of files in the playlist, only the
first N files in the playlist will be streamed.

« If the value for N is greater than the number of files in the playlist, every
item in the playlist will be played at least once.

To cycle through the playlist indefinitely, omit the -n switch.

Controlling Bandwidth

Use the -b switch bandwidth switch when your playlist consists of SureStream
files, and you want only a specific bandwidth to be broadcast. Ordinarily,
clients will choose the best possible SureStream rates for their connections.

Step 4: Linking to the Simulated Live Broadcast

Links to simulated events use the same format as for actual live events,
including the mount point that corresponds to the port number you specified
in the command line.

Additional Information

See “Part 2: Linking to the Live Event” on page 45.
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For example, if you started the simulated live event using the example shown
in “G2SLTA Example”, the link in the Web page would look like the following.
Notice that the Ramgen mount point is included.

http://realserver.company.com:8080/ramgen/encoder/annual.rm

If you want to test this broadcast before creating the Web page, type the
following directly in the RealPlayer Open Location dialog box. Notice that the
G2 Encoder mount point is included.

rtsp://realserver.company.com:554/encoder/annual.rm
Tip
Because the URL is linked to the list of streamed files via

the livefile name, you can use different playlists with
different names, yet keep the same link on the Web page.

Stopping G2SLTA

The G2SLTA program will stop automatically when it has finished playing all
the files in the playlist, according to the command line instructions.

To stop 62SLTA before it is completed, either press CTRL+C at the command
line from which you started 62SLTA (Windows), or use the KILL command
with the process ID of the 62SLTA process (UNIX).

Ordinarily, you will not need to do this unless you want to stop the broadcast
prematurely, or if you want to stop an infinite looped broadcast.

Optional G2SLTA Features

The G2SLTA program has additional options which you can configure:

- Customizing title, author, and copyright information displayed by
playlists

« Changing playlists while 62SLTA is running

Customizing Title, Author, and Copyright Information

When a clip is initially encoded, the content creator can fill out information
about the title, author, and copyright (TAC) information. You can view this
information for any clip (if the content creator supplied it) by choosing
Help>About this Presentation in RealPlayer. Other client software may have a
different method of showing the TAC information.
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Ordinarily, 62SLTA sends the TAC information for each clip as it is broadcast.
If you check the About this Presentation information as each clip is played,
you will see the information changing.

By using options within the playlist, you can override the encoded TAC
information and supply your own:

« A single set of TAC information can apply to all files in the playlist.
« Each clip in the playlist can display different TAC information.

0 To include title, author, and copyright information for the entire playlist

Type the following at the beginning of the file. The rest of the file lists the files
to be played:

Title: your title

Author: your author

Copyright: your copyright information

first_file

second_file

All files in the playlist will stream with the same TAC information.

In the following example, the information title, author, and copyright
information appears the same for every clip in the presentation:

Title: Company.com’s Annual Report

Author: Chris Lee, Executive Assistant

Copyright: Copyright 1999, Company.com

CompanylLogo.rm

Welcome.rm

President.rm

Treasurer.rm

Conclusions.rm

0 To include separate title, author, and copyright information for individual clips:
Add the TAC information to the end of each line, using the following format:
first_file?title="title_info”&author="author_info”&copyright="copyright_info”
where first_file is the name of the file; title_info, author_info, and copyright_info
are strings of any length.

If you have included an overall TAC at the beginning of the playlist, including
information about separate files will “turn off” the TAC at the beginning of
the file; subsequent clips will then stream with their own TAC information.
In the following example, separate TAC values are supplied for each clip:

CompanylLogo.rm&title="Our Founder"&author="P. Brown, artist"&copyright="1999"
Welcome.rm&title="Welcome to the Annual Meeting"
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President.rm&title="Lee Adams, President"
Treasurer.rm&title="Chris Anderson, Treasurer"
Conclusions.rm&copyright="Company.com, 1999"

Changing Playlists while G2SLTA is Running

If you are using the -n switch, either to loop the playlist infinitely or to play all
clips a specified number of times, you can take advantage of the fact that
RealServer re-reads the playlist after it plays all the clips in the playlist.

Note
If you used TAC information to provide an overall set of
information for all the clips in the presentation (by
listing that information at the beginning of the playlist),
that information will remain the same, even though the

list of files to be played is different.

0 To change the playlist while G2SLTA is Running:
1. Start G2SLTA.

2. Make changes to the playlist, and save them. Or, create a new playlist and
save it with the name of the existing playlist.

3. RealServer will use the modified playlist as soon as it plays all the clips in
the current playlist.

Using G2SLTA with Splitting and Multicasting

Creating a Source for Splitting

Instructions in this section give high-level overview steps; they assume you
already have the splitting feature enabled. For instructions on individual steps,
consult the appropriate section of this manual.

O To use G2SLTA as the live event for push splitting:

1. Run 62SLTA, using the instructions in “Step 3: Running G2SLTA”. Make
note of the value you used for livefile; you will use it in Step 2 and in Step
3.

2. If the path you typed for livefile does not already exist in the Directory
Sources section, add it now.

3. In the Web page that points to this split live stream, create a link that
points to livefile. Use the format described in “Linking to Push Split
Content” on page 168.
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O To use G2SLTA as the live event for pull splitting:

1. Run 62SLTA, using the instructions in “Step 3: Running G2SLTA”. Make
note of the value you used for livefile; you will use it in the next step.

2. In the Web page that points to this split live stream, create a link that
points to livefile. Use the format described in “Linking to Pull Split
Content” on page 176.

Creating a Source for Multicasting

Instructions in this section give high-level overview steps; they assume you
already have the multicast feature enabled. For instructions on individual
steps, consult the appropriate section of this manual.

0 To use G2SLTA as the live event for back-channel multicasting:
1. Run 62SLTA, using the instructions in “Step 3: Running G2SLTA”. Make

note of the value you used for livefile; you will use it in the next step.

2. In the Web page that points to this live multicast, create a link that points
to livefile. Use the format described in “Linking to Back-Channel
Multicasts” on page 196.

O To use G2SLTA as the live event for scalable multicasting:
1. Run 62SLTA, using the instructions in “Step 3: Running G2SLTA”. Make
note of the value you used for livefile; you will use it in the next step.

2. On the scalable multicasting page, add a channel for livefile.

3. In the Web page that points to this live multicast, create a link that points
to livefile. Use the format described in “Linking to Scalable Multicasts” on
page 202.
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Files Required by G2SLTA

The files used by the G2SLTA program are shown below.

Streamed File Type

Files Required by G2SLTA

Windows File
Name

UNIX File Name

Configuration File Variable
Showing Location of File

All

encn3260.dll

encn.so.6.0

SupportPluginDirectory

slta3260.dll

sltalib.s0.6.0

SupportPluginDirectory

enco3260.d1l

encoplin.so.6.0

PluginDirectory

RealAudio and
RealVideo

rmff3260.dll

rmffplin.s0.6.0

PluginDirectory
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UNDERSTANDING LINK FORMATS

Overview

g

pe
e

Links to RealServer content use special formats that activate
RealServer and tell the it how to deliver the requested material. This
chapter describes the theory behind the different formats that

RealServer uses.

This chapter explains how to construct the links to your content. Different
methods use different formats, but they’re all based on the same kind of
structure.

This chapter covers generic link formats, as well as link formats that apply to
all types of features (such as subdirectories in a link). For instructions on
linking to content served with a particular delivery method, refer to that
method’s chapter. Also, Chapter A, “Summary of Link Formats” gives a quick
review of all the various formats.

Tip
For examples of the different types of links, as well as
the features of SMIL files, view the demonstrations by
clicking Samples in the left-hand frame of RealSystem
Administrator, and then clicking one of the SMIL
demonstration links.

When to Skip this Chapter

This chapter provides an in-depth discussion of link anatomy, including
special directory structures. The background information provided may not
be of interest to you if you aren’t using any of RealServer’s advanced
functions.
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- If you are simply streaming on-demand content, and are storing it in the
Content subdirectory, you can use the link format described in “Linking to
On-Demand Clips” on page 137.

« If you are broadcasting live content, use the link format described in
“Creating the Link to the Live Unicast” on page 144.

Parts of a Link

A typical link to media clips served by RealServer includes elements such as a
port, a mount point, a path, and a file name.

The following illustration shows the parts of a more complex link.

Parts of a Link

— Protocol

— Address
— Port
— Mount Point

— Path
File

Y // Y s / Y / Y /

All links to material served by RealServer use the same general format:

protocol://address:port/MountPoint/path/file

RealServer URL Components

Component Meaning

protocol The protocol used for accessing the content: rtsp,
pnm, or htep.

address Address of RealServer; IP address or machine and
domain name.

(Table Page 1 of 2)
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RealServer URL Components (continued)

Component Meaning

port Port number where RealServer listens for requests sent
via the protocol listed at the beginning of the URL.

MountPoint The mount point tells RealServer how the clip should
be served. For on-demand content, usually consists of
the main mount point (a single forward slash).

path Optional; it is the subdirectory, relative to the base
path of the mount point, where the content is located.
If the file is located in the base path itself, omit path.

file The name of the presentation, including the extension.
(Table Page 2 of 2)

Protocol

The protocol is the communication protocol that RealServer uses in sending
the media clip.

RealServer uses two main protocols to communicate with clients:

+ RTSP (Real Time Streaming Protocol) for clips created and read with
RealSystem G2 tools

« PNA (Progressive Networks Audio) for clips created and read with earlier
versions of RealSystem tools

RTSP is a client-server protocol designed specifically for serving multimedia
presentations. It is an open standard, and very useful for large-scale
broadcasting. Only RTSP can deliver SureStream™ files with their multiple
bandwidth encoding. SMIL, RealText, and RealPix also require RTSP.

PNA is the proprietary client-server protocol designed and used by
RealNetworks in RealSystem versions 5.0 and earlier. The ability to serve via
PNA is supported in RealServer G2 for compatibility with older versions of
RealPlayer.

RealServer also uses HTTP to stream HTML-based material, such as Ram files
and RealSystem Administrator pages.

Additional Information

Read “Protocols Used by RealServer” on page 116.

63



CHAPTER 5: Understanding Link Formats RealServer Administration Guide

Choosing the Right Protocol

Address

Port

Links to media files streamed by RealServer can appear in four places, and use
different protocols, as shown in the following table. The protocol you use
depends on where you are placing the link, and what type of content it points
to. Notice that Web pages require a slightly different link format than the
other three venues.

Links in RealSystem Files

Alink in this location... ...that points to this type of file... ...uses this
protocol

Web page Individual clip, SMIL file, Ram file, or |http
Ramgen

SMIL files Individual file or files rtsp

Ram files Individual file or files rtsp or pnm

The Open Location dialog | Individual file rtsp or pnm

box of RealPlayer

The address is the IP address or the machine and fully qualified domain name
where your RealServer is installed. You can use either. In this book, the

example address is always RealServer.company.com, rather than the equivalent
IP address.

The port number is the number where RealServer is listening for the
appropriate RTSP, PNA, or HTTP request.

Including the port number of the RealServer machine is optional when you
use RealServer’s default port settings. If you don’t include a port number in
the URL, the client (such as RealPlayer) will supply one on its own. It looks at
the protocol, shown at the beginning of the URL, to decide which port
number to use.
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To check the port numbers in use on your RealServer, look in RealSystem
Administrator. Click General Setup > Ports.

Default Port Numbers

Protocol Port Number
http 8080

rtsp 554

pnm 7070

Reasons for Changing Port Values

You might want to change the port numbers, using RealSystem
Administrator, if multiple RealServers are using the same IP address, or if you
want to segregate requests for different material.

If your RealServer and Web server are on the same machine, you may need to
modify the HTTP Port setting. See “Running Web Servers and RealServer on
the Same System” on page 109 for information.

Note
If you change port values, you must include the new
port number in the link. If RealPlayer attempts to play a
clip for which the port information is incorrect, it may
try to request the information via HTTP, which is a
much less efficient delivery method.

Mount Point

A mount point reference appears in every URL. It is a shortcut name that tells
RealServer which feature (or file system plug-in) will be handling the request.
Most of the delivery methods each have their own mount point.

Mount points are listed in RealSystem Administrator.

In the case of on-demand content, though, the mount point is usually defined
as a single forward slash, and is therefore “invisible” in the mount point.

Some frequently used mount points are:

+ / (the single forward slash)—for on-demand content located in the
Content directory

« /encoder/—for live content digitized by encoders

- /[ramgen/—for generating a Ram file
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To determine which mount point to use (if any), you must first decide which
type of delivery method you are using. To find out the correct mount point to
use, consult the table below. The table is based on the default configuration
your RealServer was shipped with; if you have changed these values, you will
need to use the new settings.

In addition, if the link will be used in a Web page, remember to also include
the Ramgen mount point. (See “Ram Files and Ramgen” on page 69 for more
information.)

Typical Mount Points for Various Delivery Methods

Method of Delivery Mount Point To look up the mount point in
RealSystem Administrator, click
Configure, then click...

On-demand / (asingle General Setup > Mount Points
forward slash)
Live (created by encoder and /encoder/ Broadcasting > G2 Encoder or
G2SLTA) Broadcasting > Pre-G2
Encoder
Splitting—Push /farm/ Splitting > Push Source
Splitting—Pull /split/ Splitting > Pull Splitter
Multicasting—Back-Channel /encoder/ Broadcasting > G2 Encoder or
(same as live) | Broadcasting > Pre-G2
Encoder
Multicasting—Scalable /scalable/ Muilticasting > Scalable
Authenticated /secure/ Security > Commerce >
Protected Path

Including Multiple Mount Points in One Link

In some cases, a link will include more than one mount point. The Ramgen
mount point is often used in addition to other mount points. The scalable
multicast mount point is used at the same time as the live broadcasting
mount point.

For multiple mount points not covered within these chapters, consult “Using
Multiple Mount Points in a Link” in Chapter A, “Summary of Link Formats”.

Using different mount points that point to the same base path or using the
same file system can be an effective way of providing conceptual organization
of content. For example, if content on your RealServer is being supplied by
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different people, you may elect to establish a different mount point for each
person’s material, even though the material is stored on the same machine,
though in separate locations.

Mount Points and Directories with the Same Name

RealServer looks through the list of mount points before it looks for virtual or
actual directory names. Should a mount point or virtual directory have the
same name as an actual directory, RealServer will ignore the actual directory.

There is one case in which you can use this to your advantage: displaying a
message that says “Currently experiencing technical difficulties” when a live
broadcast is interrupted. Live files are sent to a mount point that does not
have a corresponding base path. Live files are streamed as they are created by
an encoder, and they never exist in file form. Create an actual directory with
the same name as the live mount point, and place a small file containing your
message in this subdirectory. If a live stream fails to arrive at RealServer,
RealServer will search for an actual directory that matches the URL. In this
case, it will find the subdirectory with the error file in it.

Additional Information
See “Playing A “Please Stand By...” Message” on page
14S5.

Path

The path value references the subdirectory (if any) where the clip is located.

+ On-demand content—include the path if the clip is located in a
subdirectory of Content. Include only the subdirectory names under
Content; you don’t include Content in the subdirectory.

If you have created an additional mount point for on-demand content,
you can determine whether a path is necessary by looking at the new
mount point and its base path. (The base path gives the actual location
for files served by the mount point.) If the on-demand clips are located in
a subdirectory of the base path, you need to include the subdirectory (or
subdirectories) in the link.

Live content—whether you include a path in the link depends on what the
content creator typed when setting up the source for your live event. If the
event is encoded, include the value for Base Directory or Virtual Directory
that you typed in the encoding software’s Server information. If you
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created the live event with 62SLTA, and you typed a virtual path as part of
the livefile value, include the virtual path.

Mount Points vs. Paths

You can’t determine which parts of a link refer to mount points and which
parts refer to virtual directories just by looking at the link; you must examine
the pages that list mount points to see which elements in a link are mount
points.

File
Finally, you type the filename at the end of the link. The filename is either the

name of the clip (in which case you must use the ramgen mount point—see
the next section) or the name of a metafile.

Sharing Information for Links

You will need to give some information to the content creator so that she can
create accurate links to the content she is creating. This information is
summarized in the table below.

Who Provides Each Part of a Link

Component Supplied By

protocol Content creator or RealServer administrator
address RealServer administrator

port RealServer administrator

MountPoint RealServer administrator

path Content creator

file Content creator

Metafiles

Metafiles are text files that you link to in Web pages. The metafiles contain
the names of the actual links. Pointing to a metafile in a link, rather than to a
media clip, allows RealPlayer to contact RealServer. There are two types of
metafiles:

« Ram files
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« SMIL files

Ram Files and Ramgen
There are two ways to reference a clip in a link:

» Create a small metafile, known as a Ram file, and point to the metafile in
the Web page link. The Ram file contains the true URL for the clip. Store
the Ram file on a Web server.

« Use the Ramgen mount point in the Web page link, and include the actual
clip file name in the Web page link.

Ram Files

Many browsers are not configured to start RealPlayer when a user clicks on a
link to RealServer content. Because of this fact, links to RealServer content
point to small text files, also known as metafiles. Web browsers can be
configured to recognize this single file type and start RealPlayer. The metafile
contains the “true” address of the media files, and RealPlayer can recognize
these.

These metafiles are called Ram files. They are small text files that list one or
more clips in sequence. They are similar in function to SMIL files, but cannot
do the sophisticated presentations that are possible with SMIL.

A user can save the Ram file (by right-clicking on the link in the Web page)
and use it to connect later (by opening it with RealPlayer), and skip the step of
downloading it from your RealServer.

Ram files are often used for backwards compatibility with previous versions of
RealServer.

Additional Information
To learn more about Ram files, including options for
start times, see RealSystem G2 Production Guide. To view
this manual, click Resources under Help in RealSystem
Administrator.

Ram File Format
A Ram file is simply a text file with the extension .ram. It can list the URL for a
single clip, or it can give URLs for clips to be played in sequence:
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Example Ram File

rtsp://address/file1
rtsp://address/file2

Creating a Ram File that Lists RTSP and PNM

One reason to use Ram files in RealSystem G2 software is that most G2
content uses the RTSP protocol, which earlier clients could not read. A Ram
file can list more than one presentation type.

A Ram file that lists two different protocols for the same clip uses the
following format:

Example Ram File with Two Protocols

rtsp://address/file
--stop--
pnm://address/file

Newer clients, such as RealPlayer versions 6.0 and later, stop reading a Ram
file when they reach the word --stop--. Older clients look for the pnm
instruction.

Ramgen: A Shortcut to Ram Files

As a shortcut to creating a Ram file for every single link you create, RealServer
G2 is preconfigured with a mount point named Ramgen, which you can add
to a link instead of creating a Ram file.

When RealServer receives a request that contains this mount point, it appears
to create and send a Ram file automatically. RealServer simply converts the
URL in the initial request to an URL within an HTTP message. The browser
appears to download a file; the information is given to the client, which
requests the correct links.

Additional Information
See RealSystem G2 Production Guide for detailed
information on using Ramgen.You can also include
commands in the links that include Ramgen references;
they are also described in RealSystem G2 Production Guide.
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To view this manual, click Resources under Help in
RealSystem Administrator.

Use Either Ram Files or Ramgen—But Not Both

You must reference either a Ram file or Ramgen in a link. Some browsers are
not configured to start the client when a SMIL or other streaming media file
is requested, but all browsers launch the client when they receive Ram files.

SMIL Files

Synchronized Multimedia Integration Language (SMIL) is a mark-up
language, based on an open standard, that specifies how and when each clip in
a file should be played. SMIL files can perform sophisticated layout and
timing instructions.

Additional Information
Refer to RealSystem G2 Production Guide for detailed
information on creating SMIL files. To view this
manual, click Resources under Help in RealSystem
Administrator.

Comparison of Ram Files, Ramgen, and SMIL

Ram File Ramgen SMIL
Can list multiple files Links to single file Can list multiple files
Can list files to be played | Lists only one file Can list files to be played
in sequence simultaneously
Cannot do any layout Cannot do any layout Performs sophisticated
layout instructions

Can refer to G2 content | All content is G2 only All content is G2 only
and previous versions (unless you use the altplay

tag in the link)
You must create a special | Fast way to test your You must create a special
file content because you don’t | file

need to make a separate file

For instructions on linking to SMIL files, see “Metafiles” on page 377.
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Where to Put On-Demand Clips

If you are just getting started with RealServer, store your media clips in the

Content subdirectory of the main RealServer directory. These clips can be

streamed immediately.

However, if you have many clips, it makes sense to organize them into

subdirectories or even to store them on different computers. Links for these

files may become quite lengthy. Adding multiple mount points, with base

paths that substitute for the lengthy paths, will shorten the links.

Location of Clips

Summary of On-Demand Clip Locations

Remarks

Content directory

When your clips are stored in this directory, links are easy to
create.
See “Storing Clips in the Content Directory” on page 73.

In a subdirectory of
Content

Include the subdirectory name in the link.
Refer to “Storing Clips in a Subdirectory of the Content
Directory” on page 73.

In a different
directory than
Content (nota
subdirectory)

Add a mount point that references the directory.
Consult “Storing Clips in a Different Directory” on page 74.

On a completely
different system

Configure your system to recognize the other location and
add a corresponding mount point that references the other
system and path.

Reference “Creating Additional Mount Points” on page 75.

72



RealServer Administration Guide CHAPTER 5: Understanding Link Formats

Storing Clips in the Content Directory

The Content directory is the main place to put clips. In the following example,
the Content directory contains two clips (music.rm and music.rp) and two
directories (Speeches and Concerts):

Example of Content Directory

(main directory)

Content
music.rm
music.rp
Speeches
Concerts

Directory Structure

Values Mount Point: /
Base Path: C:\Program Files\Real\RealServer\Content
(Windows), usr/RealServer/Content (UNIX)

The file named music.rm would have the following Web page link:
http://RealServer.company.com:8080/ramgen/music.rm

In a Ram file, use a similar format, with a different protocol and without the
ramgen mount point:

rtsp://RealServer.company.com:554/music.rm

Storing Clips in a Subdirectory of the Content Directory

Files in the Content directory can be streamed without any special changes. But
if you have a lot of files, you will probably want to organize them into
subdirectories of the Content directory. When you do, be sure to include the
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names of the subdirectories in the link to the files. Substitute the
subdirectories for path in the URL.

Example of Subdirectory of Content Directory

Directory Structure | (main directory)

Content

music.rm

music.rp

Speeches

Concerts

Classical

bach.rm
debussy.rm
vivaldi.rm

Values Mount Point: /
Base Path: C:\Program Files\Real\RealServer\Content
(Windows), usr/RealServer/Content (UNIX)

To refer to the file debussy.rm, located in the Concerts/Classical subdirectories,
include the subdirectories in the link:

http://RealServer.company.com:8080/ramgen/Concerts/Classical/debussy.rm

In a Ram file, use a similar format, with a different protocol and without the
ramgen mount point:

rtsp://RealServer.company.com:554/Concerts/Classical/debussy.rm

Tip
If you have many subdirectories within subdirectories,
consider defining an additional mount point as a
shortcut. See “Creating Additional Mount Points” on
page 75.

Storing Clips in a Different Directory

If you are going to store files in a directory which is a not a subdirectory of the
main base path, you will need to create a separate mount point for those files.
The mount point functions as a shortcut for the path information. Use the
new mount point in links to that content, in addition to any other
appropriate mount points.
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Tip
Choose a name for the mount point that reflects the
type of content streamed from this location or its
subdirectories.
O To stream on-demand files from a different directory:
1. In RealSystem Administrator, click General Setup. Click Mount Points.
2. Click Add New.

A generic mount point name appears in the Mount Points list and in the
Edit Mount Point box.

3. Type the new mount point name in the Edit Mount Point box.
4. Click Edit.

5. Type a description in the Description box.

6. Give the location of the content in the Base Path box.

7. Click Edit.

8. Click Apply.

When you create a link for the content in the new mount point’s base path,
use the new mount point. If the content is in a subdirectory of the mount
point’s base path, include the mount point and the subdirectory in the link.

Creating Additional Mount Points
Uses for additional mount points include:

« Even if your content is all stored in the Content directory, an additional
mount point can provide conceptual organization in links.

- If presentations are stored in obscure directories, a mount point can be a
brief and sensible name in the link.
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In the following example, assume a mount point has been defined as /music/,
and that it refers to the actual Concerts directory:

Example Additional Mount Points

Directory Structure

(main directory)

Content
Speeches
Concerts
Classical
bach.rm
debussy.rm
vivaldi.rm

Values

Mount Points: /music/
Base Path: C:\Program Files\Real\RealServer\Concerts
(Windows), usr/RealServer/Concerts (UNIX)

A file named debussy.rm, located in the Classical subdirectory, would have the
following link in a Web page:

http://RealServer.company.com:8080/ramgen/music/Classical/debussy.rm

It would use the following URL if typed directly in a Ram file, SMIL file, or in
RealPlayer’s Open Location dialog box:

rtsp://RealServer.company.com:554/music/Classical/debussy.rm

The full path to the file is not included. Instead, only the portion relative to
the base path is shown.

0 To create additional mount points:

1. In RealSystem Administrator, click General Setup. Click Mount Points.

2. Click Add New.

A generic mount point name appears in the Mount Points list and in the
Edit Mount Point box.

. Click Edit.

g O »nit ~A W

. Click Apply.

. Type the new mount point name in the Edit Mount Point box.

. Type a description in the Description box.

. Give the location of the content in the Base Path box.
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When you create a link for the content in the new mount point’s base path,
use the new mount point. If the content is in a subdirectory of the base path,
include the subdirectory in the link.

Recognizing Clips in a Different System

RealServer can stream files from any location that your operating
system can recognize.

0 To add a mount point for a different drive:
1. Use your operating system to identify the other drive or system.
« In Windows systems, map a drive letter to the other drive.
« In UNIX systems, mount the other system to a mount point.
2. In RealSystem Administrator, click General Setup. Click Mount Points.

3. Click Add New.

A generic mount point name appears in the Mount Points list and in the
Edit Mount Point box.

. Type the new mount point name in the Edit Mount Point box.
. Click Edit.

. Type a description in the Description box.

A=) T Y2 B N

. Give the location of the content in the Base Path box, using the
appropriate naming method for your operating system. (On Windows-
based systems, if you are mapping to a drive letter, omit the trailing slash
letter. For example, type G:, not G:\.)

8. Click Apply.

When you create a link for the content in the new mount point’s base path,
use the new mount point. If the content is in a subdirectory of the base path,
include the subdirectory in the link.

Authenticated Clips

For files that will be authenticated (the user will be asked for a name and
password—and possibly for other information— before being given access), the
files must be placed in a completely different directory, one which is not a
subdirectory of Content. It’s necessary to isolate secure material so that the
RealServer authentication feature can perform the security checks before
granting access.
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The directory or directories that contain the secure material must be at the

same level as Content, or at a higher level, or on a different system.

Example Secure Directory Structure

Directory Structure

(main directory)

Content

Speeches

Concerts

Secure
TopSecret
MembersOnly
PayPerView

Values

Mount Points: /secure/
Base Path: C:\Program Files\RealRealServer\Secure (Windows),
usr/RealServer/Secure (UNIX)

For instructions on how to set up authentication and the appropriate

directories and mount points, refer to Chapter 15, “Authenticating RealServer

Users”.

Where to Put Live Clips

Live clips, created from a production tool such as an encoder, aren’t physically
stored anywhere, so their links don’t usually include a path to an actual
directory. The link to a live event may include a virtual path, as typed in the
production tool. It may or may not correspond to any actual directories. For

live material, the path always begins with the /encoder/ mount point. See
“Virtual Paths” on page 46 for an in-depth discussion.

Example Directory Structure

Directory Structure

(main directory)
Content
Speeches
Concerts

Values

Mount Points: /encoder/
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For example, a content creator encodes a live event and names it
Speeches/Famous/Lincoln.rm. The Speeches directory is an actual directory in
this case, but it has no Famous subdirectory. The virtual directory is Famous.

In a Web page, the link to the live clip would use the following format:

http://RealServer.company.com:8080/ramgen/encoder/Speeches/Famous/
Lincoln.rm

The link to the live clip would have the following format:

rtsp://RealServer.company.com:554/encoder/Speeches/Famous/Lincoln.rm
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This chapter gives information on starting and stopping RealServer
on both Windows and UNIX platforms. As soon as you start
RealServer, it is ready to begin streaming. This chapter also explains
the RealServer license method.

Instructions in this section describe how to start and stop RealServer running
under Windows 95, Windows 98, and Windows NT.

Starting RealServer Under Windows 95 and Windows 98

You can start RealServer from the Start menu or from a command line.
To start RealServer from the Start menu:
On the Start menu, click Programs>Real>RealServer G2. This starts the

rmserver.exe program.

A command window appears, and shows the files loaded. It then displays
process ID (PID) numbers. You can leave this window on-screen, or minimize
it.
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Windows 95 and Windows 98 Startup Screen

C:\Program Files\Real\RealServer\Bin>rmserver ..\rmserver.cfg
Creating Server Space...

Process #1 PID 9440144

Starting RealServer 7.0 Core...

Loading RealServer License Files...

I: Loading Plugins...

I: C:\Program Files\Real\RealServer\Plugins\allo3260.dll RealNetworks
Basic Allowance Plugin

(more plugins are shown)

Process #2 PID 9772896 Created
Process #3 PID 9773040 Created
Process #4 PID 9775568 Created
Process #5 PID 9782464 Created

If this is the first time you have run RealServer, it loads the default
configuration file.

O To start RealServer from a command line:

Move to the main RealServer directory and type the following at a command
line and then press Enter:

Bin\rmserver rmserver.cfg

The startup screen, as shown in “Windows 95 and Windows 98 Startup
Screen” appears.

Starting RealServer Under Windows NT

In Windows NT, RealServer is automatically installed as a service, named
RMServer, unless you cleared that option during setup. As a service,
RealServer is always running in the background.

Starting RealServer Manually
You can start RealServer from the Start menu or from a command line.

If RealServer is already running as a service, do not try to start it a second
time. If you want multiple instances of RealServer, use the instructions in
“Running Multiple Servers on One System Under Windows NT”.
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0 To start RealServer from the Start menu:

On the Start menu, click Programs>Real>RealServer G2. This starts the
rmserver.exe program.

If this is the first time you have run RealServer, it loads the default
configuration file.

O To start RealServer from a command line:

Move to the main RealServer directory and type the following at a command
line and then press Enter:

Bin\rmserver rmserver.cfg

If you start it without including a configuration file, RealServer uses the most
recently used configuration settings.

Setting Up RealServer as a Service Under Windows NT

RealServer on Windows NT can be run as a service; an option during setup
configures this automatically. Instructions in this section describe how to add
RealServer to the services list if you did not instruct setup to do so.

O To install RealServer as a service:
1. At a command prompt, move to the RealServer Bin directory.
2. Import the configuration file you want to use into a specific key in the
registry by typing the following:
rmserver.exe -import[:key] configuration_file
where:

key is the Registry key name you want to use. If you omit it, the default
name Config is substituted.

configuration_file is the path and configuration file you want to import.

Note
The configuration file you use must contain absolute
paths for variables such as BasePath. Relative paths will
not be recognized by RealServer when itis run asa
service.

For example, the following command:

rmserver.exe -import:Serverl ../rmserver.cfg
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imports all the values in the rmserver.cfg file into the following key of the
Windows NT registry:

HKEY_CLASSES_ROOT\Software\RealNetworks\RealMedia Server\7.0\Server1

Note
You must supply the path to the configuration file. If
RealServer cannot find the configuration file, it may not
start.

Tip
You can now start RealServer using this configuration
by typing the following at a command line:
rmserver.exe registry:Serverl

3. Install the service by typing the following command at a command
prompt:
rmserver.exe -install[:ServiceName] "parameters"

where:

ServiceName is the name that will appear in the Services dialog box. If you
omit ServiceName, RMServer is substituted.

parameters is either the name of the configuration file, or the registry and key
name, as entered in Step 2. The format of the registry and key name is
registry:key. Any command line parameters, such as the -m switch, can be
used.

Note
The quotation marks surrounding parameters are
required.

The next time you start RealServer from the Services dialog box, it will use
the settings specified in parameters, and will be configured to start
automatically.

For example, the following command:

rmserver.exe -install:RMInternet "Server1"

installs RealServer with the service name “RMInternet” and uses the
settings in the Serverl key.

4. Start the service. In the Services control panel, select the name you used
for ServiceName, and click Start.
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O To remove any RealServer from the services list:
At a command prompt, type the following:
rmserver.exe -remove[:ServiceName]
where ServiceName is the optional name of the service. If you omitted a service

name when you installed the service, you can omit it here, and RealServer will
use RMServer.

Additional Options for Windows NT
Under Windows NT, the following option is available:

« Installing multiple, separate instances of RealServer

Running Multiple Servers on One System Under Windows NT

You can load different configuration files into different Windows NT registry
keys, and connect them to different instances of RealServer running as
separate services. Multiple services of RealServer can be useful if you want to
switch between a production and a test configuration file, for example.

0 To import a configuration file into a specific key in the registry:

1. Follow the instructions in Step 2 of “Setting Up RealServer as a Service
Under Windows NT” to import a particular configuration file into a
specific registry key.

2. Start RealServer by typing the following:
rmserver.exe registry:key

where:

key is name you want to use for the configuration. RealServer places the
configuration information in
HKEY_CLASSES_ROOT\Software\RealNetworks\RealMedia Server\7.0\Key.

In the example from Step 2 of “Setting Up RealServer as a Service Under
Windows NT”, in which the configuration settings are loaded into the
“Serverl” key, the full key name would be
HKEY_CLASSES_ROOT\Software\RealNetworks\RealMedia Server\7.0\Serverl.

Stopping RealServer Under Windows and Windows NT

If RealServer was started from the Start menu or the command prompt,
switch to the command window and press CTRL+C.
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UNIX

In Windows NT, if RealServer was started as a service, stop RealServer through
the Services control panel. Click Start>Settings>Control Panel. Double-click
Services. Locate RMServer on the list (your service name may be different),

highlight it, and click Stop.

Instructions in this section describe how to start and stop RealServer running
under UNIX.

Starting RealServer Under UNIX

Start RealServer initially with the default configuration file; later, you can
create other configuration files and start RealServer using those.

RealServer includes one default port setting that is lower than 1000 (port 554
for the RTSP Port). Because the use of ports lower than 1000 requires that the
person starting RealServer have root privileges, you must log in as root before
you can start RealServer.

To run RealServer as a specific user, configure the User and Group variables
with the appropriate User and Group names. Although your RealServer will
start as root, it will automatically be switched to use the User and Group
names you indicated. Refer to “UNIX-Only Features” on page 111.

To start RealServer under UNIX:
Move to the main RealServer directory and type the following:

Bin/rmserver rmserver.cfg

If you do not start from the Bin directory, RealServer cannot understand the
relative paths in the configuration file.

To start RealServer in the background:
Type the following from the main RealServer directory:

Bin/rmserver rmserver.cfg &

If you have other configuration files, you can substitute their names for
rmserver.cfg and RealServer will use the settings in the file you name.

To limit the amount of memory that RealServer G2 uses:
Start RealServer with the -m parameter:

Bin/rmserver rmserver.cfg -m 32
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where the number after -m can be any amount of memory in megabytes, 32 or
greater. (This parameter is not necessary on FreeBSD and Linux.)

Stopping RealServer Under UNIX

To stop RealServer under UNIX, obtain the parent process identification
number, and then issue the kill command with that process number. The
process ID is stored in the rmserver.pid file, which is usually kept in the Logs
directory. The PIDPath variable specifies this location.

You can perform both actions with one command. Move to the directory
which contains the RealServer PID file, and type the following:

kill “cat pidfile’

where pidfile is the name of the RealServer PID file, as shown in the PIDPath
variable.
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License Information

Information about the license for your RealServer, including a list of enabled
features, is stored in a file in a license directory. If you purchase additional
features, these may be listed in additional files stored in the same directory.
The license files are written in XML format.

You can read the file with RealSystem Administrator by clicking About in the
left-hand frame. A second browser window appears, displaying the values for
your license file. If you have multiple license files, RealServer will show the
values for all of them at once.

You can also read the file with any text editor. Although you can read the file
with a text editor, you cannot make changes. Any changes to the file invalidate
it. If you have multiple files, you will need to read each file individually and
calculate any additive features (such as number of streams) yourself.

The LicenseDirectory variable in the configuration file tells RealServer where to

look for license information.

Additional Information
To learn about the configuration file, see
“Configuration File” on page 94.

If the license file is invalid, RealServer will report an error message, add the
error to the error log file, and will not start. To resolve this, remove the license
file, and restart RealServer. It will use minimum settings, as described in the
“Minimum Settings” table. Contact RealNetworks for a correct license file.

The following features are controlled by the license:
« Number of streams
« Splitting—whether the RealServer can act as a source or splitter
+ Multicasting
« Authentication
« ISP hosting
+ Ad streaming
» Data types (such as Real G2 with Flash)

If your RealServer suddenly allows fewer connections or otherwise appears to
be using minimum settings, either your license has expired or RealServer is

88



RealServer Administration Guide CHAPTER 6: Starting and Stopping RealServer

unable to start using the settings you've selected. The table below lists the
minimum settings present in every RealServer.

Minimum Settings

Feature Value

Number of streams 25

RealPlayer versions Only RealPlayer versions 5.0 and later are allowed to
connect.

Splitting Acts as pull splitting source. Cannot act as pull splitter,
push source, or push splitter.

Multicasting Disabled

Authentication Encoder and RealSystem Administrator users can be

authenticated. Links to content cannot be authenticated.

Data types RealVideo and RealAudio are enabled; all other types
(Real G2 with Flash, WAV, AVI, VIVO) are disabled.

Note
Evaluation versions may have lower minimum values
and additional features.

To upgrade your license so that you can use more of RealServer’s features,
contact RealNetworks or your reseller.
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RealServer settings are customized through the RealSystem
Administrator. This chapter describes how to use RealSystem
Administrator as well as the basic settings used by all RealServers.

To monitor and modify your RealServer, use RealSystem Administrator. Any
adjustments you make are stored in a configuration file. There are a few
specific features which can only be adjusted by editing the configuration file
directly. These are highlighted in “Features Only Available Via Direct Editing”
on page 430.

Customizing RealServer Using RealSystem Administrator

RealSystem Administrator is the Web-based console for customizing
RealServer features. It can be run from any browser on your network. It is
password-protected when first installed, and you can create additional user
names and passwords for any other people who will be helping you administer
your RealServer.

When the RealServer installation program completes, it asks if you want to
start RealServer and run RealSystem Administrator. If you choose yes,
RealSystem Administrator asks you for a name and password, then it starts.

To make changes to any feature, click on the appropriate category listed under
Configure. Make the changes and click Apply. A confirmation page appears to
let you know that the changes have been made. You may be required to restart
RealServer; a message to that effect will appear if it is necessary.

If your Web browser is set to permit cookies, RealSystem Administrator
“remembers” the page that was open in the right-hand frame the last time you
used it or when you click the refresh button. In Netscape Navigator,
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RealSystem Administrator will reload with the main Welcome page when you
resize the browser window unless cookies are enabled.

RealSystem Administrator Welcome Page

- Locatirs [ritp:/172 23 102 58031 /acdwrvindes hird

Starting RealSystem Administrator

You can view the configuration of your RealServer from nearly any browser on
your network. Compatible browsers are Netscape Navigator version 4.06 or
higher and Microsoft Internet Explorer version 4.0 or higher.

0 To start RealSystem Administrator:
1. Start RealServer. See Chapter 6, “Starting and Stopping RealServer”.
2. In a browser, type the following address:

http://address:AdminPort/admin/index.html

where:

address is the IP address or host name of the machine on which RealServer
is installed.

AdminPort is the port which RealSystem Administrator uses to connect to
RealServer. You were asked for a port number during setup. Use that port
number here.
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The following URL will start RealSystem Administrator if it is typed in the
browser on the same computer as RealServer (be sure to substitute your
port number for AdminPort):

http://127.0.0.1:AdminPort/admin/index.html
The following command also works on the same computer:
http://localhost:AdminPort/admin/index.html

3. You are prompted for your user name and password; these will match the

values you entered during setup. (To change these values, see Chapter 15,
“Authenticating RealServer Users”.) Click OK.

RealSystem Administrator appears.
Tip
Bookmark this location so that you can easily return
here at any time.

Using RealSystem Administrator

Once you have started RealServer and RealSystem Administrator, you can
change RealServer features with the instructions below:

0 To customize RealServer settings:

1. In RealSystem Administrator’s left-hand frame, click the appropriate
category below Configure.

2. Change the values in the page on the right.
3. When you have finished changing values, click Apply.

If you made changes that require the Server to be restarted, the Pending
Changes button at the top of RealSystem Administrator changes to red.

In addition, the Restart Server button, located at the at the top of the
RealSystem Administrator window, turns red if you need to restart
RealServer for your changes to take effect. When you see the Restart
Server button change its color to red, you should click it as soon as it is
convenient.

Restricting Access to RealSystem Administrator

To ensure that only certain people can use RealSystem Administrator to make
changes to RealServer, you can authenticate all connections to RealSystem
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Administrator. Instructions are given in “RealSystem Administrator User
Authentication” on page 236.

Configuration File

Changes made with RealSystem Administrator are stored in the configuration
file, named rmserver.cfg. It is a text file formatted with tags which are based on
XML (Extensible Markup Language). This language introduces great
flexibility to the configuration file format and allows third-parties to use this
file and add to its functionality. Syntax of this file is given in Appendix C,
“Configuration File Contents”.

Be sure that your configuration file is stored where only authorized users can
make changes to it.

Tip
Keep a backup copy of the configuration file. You may
need it if you make changes to this file that you later
want to undo or if you accidentally delete the working

copy.

Editing the Configuration File with a Text Editor

A few specialized elements can only be changed by editing the file directly;
they are noted in the text where they appear. In addition, third-party plug-ins
may require their own parameters and variables, which cannot be added or
modified through RealSystem Administrator; use a text editor to add them to
the configuration file.

Additional Information
Appendix C, “Configuration File Contents” gives
instructions on using a text editor to modify the
configuration file directly.
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Common Settings

Regardless of which features are in use, certain settings are used by every
feature and apply to every RealServer. They are described in this section.

Port Numbers

Port settings tell RealServer where to listen for requests. Ports are described in
detail in Chapter 3, “Overview”.

If your RealServer and Web server are on the same machine, you may need to
modify the HTTP Port setting. See “Running Web Servers and RealServer on
the Same System” on page 109 for additional information.

Otherwise, you will probably not need to make any changes to the port
settings.

Note
If you change the port numbers for RTSP Port, PNA Port
and HTTP Port from their default values, you will need
to tell your users so that they can include the new ports
in their links. (If a link does not include a port number,
RealPlayer uses default values for contacting the
RealServer. But if RealServer is no longer listening on
those ports, it will not receive the request.)

RealServer uses the following settings to determine where to listen for requests
sent via a particular protocol (you can view the settings from RealSystem
Administrator by clicking General Setup>Ports):

« PNA Port—the port where RealServer listens for material requested via
PNA (such requests begin with pnm://). The default value is 7070. Previous
versions of RealSystem used this protocol.

« HTTP Port—the default value for this setting is 8080.

 RTSP Port—where RealServer listens for RTSP requests (these begin with
rtsp://). At installation, the value is 554.

Note
To use a port lower than 1024 on a UNIX system, you
must be logged on as super-user.

+ Monitor Port—port used by Java Monitor. The default value is 9090.
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+ Admin Port—port number to which RealSystem Administrator
connection requests are directed. The value for this setting is selected at
random during setup to ensure security, and can be overridden by the user
during setup.

Mount Points

Mount points on this page refer to on-demand clips. For a complete
description of mount points, see “Mount Point” on page 65. Mount points in
other sections, such as for live material, are described in their respective
chapters.

You do not need to change this setting unless you want to keep your media
clips somewhere other than the Content directory or its subdirectories.

RealServer uses the following mount points when it is first installed:

+ Main mount point (represented by /)—This refers to all content streamed
by this RealServer

« secure—Content that will be authenticated is identified with this mount
point
O To change the base path of the main mount point:
1. In RealSystem Administrator, click General Setup. Click Mount Points.
2. In the list on the left, select /.
3. To change the base path, type the new path in the Base Path box.
4. Click Apply.
0 To add another mount point:

1. In RealSystem Administrator, click General Setup. Click Mount Points.

2. Click Add New.

A generic mount point name appears in the Edit Mount Point box.
. Type the new name in the Edit Mount Point name box. It must be unique.

3

4. Click Edit.
5. Give a description for this new mount point in the Description box.
6

. Identify the location of the content by typing the full path in the Base
Path box.

7. Click Apply.
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MIME Types

MIME Types on a Web Server

RealServer works with any Web server that supports configurable MIME
types. Make sure that your Web server has the RealNetworks MIME types

defined.

Refer to the instructions accompanying your Web server to define the
following MIME types on your Web server. Of the items on this list, only
MIME types for the extensions .ram and .rpm are required. Other applications
may use other types shown in the table.

Web Server MIME Types and Extensions

MIME Types

Extensions

audio/x-pn-realaudio

ra, rm, or ram

audio/x-pn-realaudio-plugin rpm
application/x-pn-realmedia rp
application/smil smi or smil
application/sdp sdp
image/gif gif
image/jpg jpg, jpeg
text/html html, htm

MIME Types on RealServer

In addition, RealServer acts as a Web server for certain features. To this end,
RealServer has its own MIME types section. You should only modify the list of
MIME Types if you will be streaming a data type via HTTP that is not on the
list. The following table shows RealServer’s initial settings.

RealServer MIME Types and Extensions

MIME Types Extensions
audio/x-pn-realaudio ram
image/gif gif
image/jpg ipg, jpeg
text/html html, htm
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ter

h II“
This chapter covers features that are specific to the operating
system, such as allowing users to view the source code of SMIL files
and media clips, as well as reserving IP addresses for RealServer’s

use, running RealServer on the same system as a Web server, and

working with firewalls.

Displaying Source Code for SMIL Files and Media Clips

View

Just as users can right-click an HTML file and view the HTML code that was
used to create a Web presentation, RealServer contains a feature that allows
users of RealPlayer 7.0 to view the source code for SMIL presentations or
information about media clips. When a user right-clicks on a presentation or
selects View>Clip Source, RealServer sends a Web page that contains the text of
the SMIL file, or data about the clip, to the user’s browser.

Users can then “learn by example” and understand how to create their own
SMIL files. Content creators will find this feature useful when they
troubleshoot SMIL files.

Source on SMIL Files

The HTML page that displays the text of the SMIL file also links to
information about each clip referenced by the SMIL file. The information
shown on these pages describes the contents of the entire file, including
information such as file size, buffer time, and bit rate.

RealServer sends the text of the SMIL file to the browser using an
automatically generated Web page. In the browser’s address box, the URL
shown is:

http://RealServer.company.com:8080/viewsource/template.html?ABcdlkj293847

By default, the name and path of the SMIL file are not shown; random
numbers and letters are displayed instead. (You can make the SMIL path and
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file name appear; use the instructions in “Allowing Users to See Complete
Paths in SMIL Files” on page 103.)

Security

Within the text of the SMIL file in the browser, all references to other files are
shown as hyperlinks. Clicking these links displays another Web page, with
detailed information about each referenced file.

This feature is especially helpful for content creators, as it also allows them to
see detailed information about the components of the SMIL file.

To protect the location of your content, this feature is initially configured to
omit the full path of the clips referenced in the SMIL file, showing an ellipses
(...) instead. You can also disable this feature for some or all paths.

Note
For content on your local computer, paths are always
shown. They cannot be hidden.

Listing All On-Demand Content

The content browsing feature creates a Web-based directory with links to all
on-demand content available on to your RealServer. By clicking View
Source>Browse Content Now in RealSystem Administrator, you generate the
index. Only other administrators who know the correct URL, user name, and
password for RealSystem Administrator can view on-demand content
available to this RealServer.

A Note About Web Servers

Although it is not the preferred delivery method, some content creators serve
SMIL and media from Web servers. When a user selects View Source for
content delivered by a Web server, the paths that appear in the SMIL file are
hidden. Source information is available for all other media clips delivered by
the Web server. Since RealServer has no control of Web servers, settings used
for the View Source feature in RealServer have no effect on how the source
code is displayed for content served by Web servers.

View Source and RealServer Features

The view source feature interacts with other RealServer features.
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Streaming, Unicasting, and View Source
The view source feature applies to both on-demand and live content.

The browse content feature applies only to on-demand content.

Archiving and View Source
The browse content feature is a good way to take inventory of your Archive
directory.

G2SLTA and View Source
On-demand files which are converted to live files through the use of G2SLTA
show the same information as any other live files.

Splitting and View Source
View source is disabled for users who are receiving a broadcast through a
backup push splitting source.

Access Control, Authentication, and View Source

The view source feature is automatically disabled for all secure content.

Reporting and View Source

A record is created in the access log when a user makes a view source request.
See the “Summary of GET Statements” table on page 301.

Changing View Source Settings

In RealSystem Administrator, click View Source, then click Source Access. At
installation, the settings are:

« View Source—Set to Yes, for the main mount point (/)

+ Hide Paths—Set to Yes (paths will be hidden)

Optional View Source Features
The view source feature has these options which you can customize:
« Displaying source code only for certain streams
« Allowing users to see complete paths in SMIL files

« Temporarily overriding individual path settings
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Displaying Source Code Only for Certain Streams

You can choose to enable the view source feature for a limited number of
paths, or, conversely, to enable it for most paths but disable it for only a few.

0 To enable view source for a few specific streams:
1. In RealSystem Administrator, click General Setup. Click Source Access.
2. In the Paths list, select the single forward slash (/).
3. From the View Source list, select No.

4. Click Add New.

A generic path name appears in the Edit Path box.

[

. In the Edit Path box, replace the generic path with the name of a path for
which you want to enable the view source feature.

6. Click Edit.
7. In the View Source area, select Yes.
8. Repeat Step 4 through Step 7 for each path you want to enable.

9. In the Master Settings area, from the View Source list, make sure Use
Settings Above is selected.

10. Click Apply.
0 To enable view source for most streams, but disable it for a few:
1. In RealSystem Administrator, click General Setup. Click Source Access.
2. In the Paths list, select the single forward slash (/).
3. From the View Source list, select Yes.

4. Click Add New.

A generic path name appears in the Edit Path box.

[

. In the Edit Path box, replace the generic path with the name of a path for
which you want to disable the view source feature.

6. Click Edit.
7. In the View Source area, select No.
8. Repeat Step 4 through Step 7 for each path you want to enable.

9. In the Master Settings area, from the View Source list, make sure Use
Settings Above is selected.
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10. Click Apply.

Temporarily Overriding Individual Path Settings

In the Master Settings area, the settings for View Source and Hide Paths are
normally Use Settings Above. By selecting one of the other two options, Disable
View Source or Enable View Source, or Show All Paths or Hide All Paths, you can
leave the settings of the individual paths intact, but supersede them with the
new values. This can be useful for temporary troubleshooting, or for disabling

the feature quickly and globally.

Of course, these settings do not have to be temporary. They stay in effect until
you change them.

Allowing Users to See Complete Paths in SMIL Files

At installation, view source is configured to “hide” the paths of the clips
referenced in SMIL files. This protects the privacy of the content creators, and
allows the user to focus on the syntax used within the SMIL file.

For example, the following tag within a SMIL file:

<video src="rtsp://RealServer.company.com/houseg2/house.rm”
region="VideoRegion">

appears as the following:
<video src="rtsp://.../house.rm” region="VideoRegion”>

Identifying information is removed, and only the protocol and file name are
shown.

0 To include full path information:

1. In RealSystem Administrator, click View Source. Click Source Access.

2. In the View Paths list, select the path for which you want to allow users to
see the source.

3. In the Hide Paths list, select No.

4. Click Apply.

Browsing Your Content

The content browsing feature creates a Web-based list of all on-demand
content that your RealServer can stream.

If the clips are stored on your hard drive, full paths are always shown.
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O To browse the on-demand content:

In RealSystem Administrator, click View Source. Click Browse Content Now.

A new browser window appears, containing two columns. Along the left
column, labelled Info, the word “Directory”, “MountPoint”, or a file size
appears. The next column shows a file name. The third column contains a link
to the file.

Changing Content Browsing Settings

In RealSystem Administrator, click View Source, then click Content Access. At
installation, the settings are:

+ Mount Points to Browse—Set to /, for the main mount point (/)

« Extensions to Browse—Set to * (all file types will be browsable)

Optional Content Browsing Settings
0 To browse more mount points:
1. In RealSystem Administrator, click View Source. Click Content Access.

2. Click Add New.

A generic mount point name appears in the Edit Path box.

3. In the Edit Path box, type the name of a mount point that you want to be
able to browse.

4. Click Edit.

5. If you want to limit the file types that are included in the generated list,
type them in the Extensions to Browse box. For example, you might want
to include just the extensions smi and smil.

6. Click Apply.

RealServer Caching Features

RealProxy is software that stores streamed media. While it is not part of
RealServer G2, it can work with RealServer to share the distribution load,
thereby conserving bandwidth over an intranet and allowing RealServers to
send streams to a wider audience. It is generally installed on an intranet or on
a large Internet Service Provider (ISP). When a client on the intranet or hosted
by the ISP requests a streamed media file, RealProxy intercepts the request and
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sends it on behalf of the client. RealProxy then stores the requested media and
streams it to any other clients who subsequently request the same material.

RealServer is designed to work with RealProxy. RealServer is configured at
installation to allow all content to be cached by RealProxy. This ensures that
clients whose requests are sent via RealProxy will be able to view your content.
Also, because more than one RealProxy is now rebroadcasting some of your
content, your RealServer now has more connections available.

Only on-demand content can be cached by RealProxy.

Caching and RealServer

This section describes how RealServer interacts with RealProxy software.

Streaming On-Demand Clips and RealProxy

All on-demand clips are automatically available to media caching software. If
there is content served by your RealServer which you do not want to be cached
by a media cache, you can mark it as non-cacheable, on a per-file or per-folder
basis.

Unicasting, Splitting, Multicasting and RealProxy

Live clips are not available to media caching software; RealProxy will still proxy
the live broadcasts for clients. RealServer acts as a source for pull splitting, and
RealProxy acts as a splitter.

Access Control and RealProxy

RealServer does not see the IP addresses of the individual clients that request
content; instead, it sees the IP address of the RealProxy. You can prevent
specific RealProxys from requesting material on behalf of clients (see
“Preventing Certain RealProxys from Accessing Your RealServer” on page 108).
But if you do, you will also prevent all those clients from accessing your clips.

Authentication and RealProxy

Before allowing cl